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INTRODUCTION

HOPEX Business Process Analysis is software edited by MEGA International to assist:

v
v

This is used to

v

SNENENENEIEN

Organizers in improving and redesigning enterprise business processes.
Quality engineers describing the business processes of their organization.

Description of the detailed organization of operations during execution of
organizational processes, and the participation of each of the enterprise org-units
in these processes.
Description of product or service offerings proposed by enterprise business
processes.
Description of enterprise value streams.
Description of the enterprise organizational chart.
Identification of the risks linked to the enterprise processes.
Detailing of information system requirements involved in these application
business processes. It is then possible to draw a map of the enterprise
organization and information system (in conjunction with HOPEX IT
Architecture).

w  The description of processes with HOPEX Business Process

Analysis is based on the Business Process Modelling Notation (BPMN)
maintained by the Object Management Group (OMG).

The following points are covered in HOPEX Business Process Analysis:

NN N N N N S NENEN

"Organizational Processes", page 35

"Business processes", page 69

"Value streams", page 77

"System Processes", page 83

"Conversations", page 97

"Organizational Charts and Responsibilities”, page 111

"The customer journey", page 125

"Assessments With HOPEX Business Process Analysis", page 161
"Action Plans with HOPEX Business Process Analysis", page 171
"HOPEX Business Process Analysis Reports", page 175.
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PRESENTATION OF HOPEX BUSINESS PROCESS ANALYSIS

Combined with the products of HOPEX suite, HOPEX Business Process Analysis
supports a methodology and the tools used to describe your business organization
and manage change.

Because business modeling helps you:

e Explaining how your enterprise operates
Considering changes in the organization
Defining IT requirements
Identify the risks linked to the enterprise processes
Specifying interactions with partners

Explaining how your enterprise operates

There are three situations in which an explanatory diagram of processes
implemented in an enterprise can enable better understanding of its operation:

e When a person is hired.

e When a person’s duties change.

e When instructions are not fully understood.

The standard organizational chart provides you with only an overview showing the
organizational unit hierarchy, without explaining how the enterprise functions. A
process diagram helps you better understand how your enterprise operates.

Considering changes in the organization

Management must improve processes in an enterprise in order to eliminate
weaknesses. Management can go further by transforming certain processes so that
they become key competitive advantages for the enterprise.

Formally defining processes is a way to highlight those areas needing improvement.

Defining IT requirements

You can complete the process descriptions with the information technology means
required:
e The functionalities (which may or may not be IT) required to execute
each operation.
e The applications and the application services used.
e Other material or human resources required to carry out the process.

Identify the risks linked to the enterprise processes

The description of processes can be completed with the risks identified at each step
of these processes or with IT resources or other equipment or human resources that
they need.

HOPEX Business Process Analysis
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Specifying interactions with partners

Interactions with partners of the enterprise should be precisely defined to enable
automation of exchanges between the business processes of the enterprise and
those of its partners as part of an e-business or EAI (Enterprise Application
Integration) project.

Modeling with HOPEX Business Process Analysis

HOPEX Business Process Analysis offers tools enabling enterprise organization
description.

Describing processes

You can write comments for each process element directly from the diagram. This
offers many advantages:
e Description of each element is simpler and faster than writing the
complete process.
Reports can be built automatically.
Easy retrieval of process descriptions for insertion into other processes.
The volume of text is significantly reduced.

Producing documents

Documents are automatically generated from the elements entered when describing
the diagram.

The general structure is independent of the writer.

Document generation is automatic.

Documents have a standard layout and consistent style.

Descriptions are automatically reused in the different documents.
Document consistency is assured.

© vYoucan modify the layout and formatting of documents generated
by HOPEX Business Process Analysis and create new ones. See the
HOPEX Power Studio guide.

HOPEX Business Process Analysis allows you to automatically generate an
Intranet site describing the processes used in the enterprise.

Upgrading and maintaining your processes

As your organization evolves, so do your processes.

11
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HOPEX Business Process Analysis allows you to make your changes in one
location, and have them propagated to all processes involving those elements. This
allows:
e Rapid access to the elements that you want to modify.
* You can analyze impacts of modification of a process in other processes
in which this element appears.
e Automatic regeneration of all documents concerned.

This User Guide is designed to help you quickly discover the power of HOPEX
Business Process Analysis.

Positioning of the HOPEX Business Process Analysis solution

HOPEX Business Process Analysis can be used with other products in the
HOPEX suite.

HOPEX Business Architecture

The HOPEX Business Architecture solution is based on tools offered by the
HOPEXplatform to support business transformation on the basis of the analysis of
business capabilities and the enterprise model.

Business Architecture helps managers define the operating architecture of their
enterprise to remain in compliance with its Business Model and to adapt to changes
in the enterprise and in its economic and regulatory environment. HOPEX Business
Architecture is thus a key tool for enterprise transformation

HOPEX Business Process Analysis thus provides HOPEX Business
Architecture with:

e The description of organizations that implement the business functions
and/or the business function capabilities identified in HOPEX Business
Architecture;

e The description of organizational processes that implements the value
streams identified in HOPEX Business Architecture.

HOPEX IT Architecture

The HOPEX IT Architecture solution provides HOPEX Business Architecture
with the possibility to define whether business capabilities, functionalities or
business functions are implemented by resource architectures or application
systems and applications.

HOPEX Portfolio & Planning

By means of portfolio management, HOPEX Portfolio & Planning enables
planning over time of development of information systems, organizations and more
generally all enterprise architecture.

HOPEX Business Process Analysis
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HOPEX Risk Mapper

The HOPEX Risk Mapper solution provides HOPEX Business Process Analysis
with the possibility to associate risks with business functions and value streams.

HOPEX Business Process Analysis Profiles

In HOPEX Business Process Analysis,there are profiles associated to specific
activities.

Presentation of the solution interface depends on the profile selected by the user on
connection to the application; the tree of menus and functions varies from one
business role to another.

w  For more details on the Desktops connected to each of the profiles,
see "HOPEX Business Process Analysis Desktop Presentation”, page 24.

Profiles Tasks

Process Functional Administrator In addition to the functional rights of the Process Manager, the
Process Functional Administrator has rights to all objects,
methods, projects and workflows.

Prepares the work environment and creates elements required
for management of process.

He manages:

- Users, assignment of roles and access rights to the different
project steps.

- all environment objects (processes, customer journeys,
reports, etc.),

- Workflows.

For more details, see "Presenting the Functional Administrator
space", page 26.

Process Manager The Process Manager has rights to all objects, methods, proj-
ects and assessments.

For more details, see "Presenting the Process Manager space",
page 25.

13
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Profiles

Tasks

Process Designer

The Process Designer is responsible for creating the value
streams and organizational process models entrusted to him/
her. In addition to the tasks assigned to the Process Designer
(basic), the Process Designer can manage transformation proj-
ects.

For more details, see "Presenting the Process Designer space",
page 27.

Process Designer (Basic) The Process Designer is responsible for creating the value

streams and organizational process models entrusted to him/
her.

For more details, see "Presenting the Process Designer space
(basic)", page 28.

Process Contributor

The contributor to a process is responsible for validating the
design of the processes entrusted to him/her.

For more details, see "Presenting the Process Contributor
space", page 28.

Business Roles of HOPEX Business Process Analysis

In HOPEX Business Process Analysis, there are, by default, business roles that
can be assigned to certain users. These roles are:

Value streams Designer to assign a user to value streams. The Value
streams Designer is responsible for designing the value streams assigned
to him/her.

Business Process Designer to assign a user to functional processes.
The Business Process Designer is responsible for designing the processes
assigned to him/her.

Organizational Process Designer to assign a user to organizational
processes. The Organization Process Designer is responsible for
designing the processes assigned to him/her.

Org-Unit Designer to assign a user to org-units of the organization.
The Org-Unit Designer is responsible for managing the processes
assigned to him/her.

Organization Process Contributor which is used to assign a user to
organizational processes. The contributor to an organizational process is

HOPEX Business Process Analysis
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responsible for validating the design of the processes entrusted to him/
her.

¢ Process Portfolio Manager to assign a user to process portfolios. The
Portfolio Manager is responsible for managing the portfolios assigned to
him/her.

e Business Process Owner to assign a user to functional processes. The
Business Process Owner is responsible for the following tasks:

e Identifies risks

e Responding to Questionnaires

e Defining and implementing action plans,

e Validating modifications made by the Business Architect in the context
of object review workflows.

e Organizational Process Owner to assign a user to organizational
processes. The Organization Process Owner is responsible for the
following tasks:

e Identifies risks

e Responding to Questionnaires

e Defining and implementing action plans,

e Validating modifications made by the Business Architect in the context
of object review workflows.

15
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THE HOPEX BUSINESS PROCESS ANALYSIS METHOD

The method embedded in the HOPEX Business Process Analysis solution is used
to perform the following tasks:

e "Preparing the Work Environment", page 16

e "Building customer journeys", page 16

e "Describing the existing organization", page 17

e "Managing organizational transformation", page 22

Preparing the Work Environment

Libraries are collections of objects used to split repository content
into several independent parts. They allow creation of virtual partitions
of the repository. In particular, two objects owned by different libraries
can have the same name.

In the context of the HOPEX Business Process Analysis solution, a library can
hold all the elements of your project: processes and org-units, for example.

w  For more details on managing libraries, see the "Enterprises and
Libraries" chapter in the HOPEX Common Features guide.

Accessing the list of libraries with HOPEX Business Process Analysis

To access the list of libraries from the Environment navigation pane:

) Select Standard Navigation > Standard Navigation in the navigation
menu.
The library tree appears.

Creating a library with HOPEX Business Process Analysis

To access the list of libraries from the Environment navigation pane:
1. Select Standard Navigation > Standard Navigation in the navigation
menu.
The library tree appears.
2. Select New > Library.
A Library creation dialog box opens.
Specify the the name of the library.
If appropriate, enter the name of the Owner.
Click OK.
The library appears in the tree.

Al ol o

Building customer journeys

The HOPEX Customer Journey module is used to represent the acquisition
process of a product or a service by a specific customer. Mapping a customer

HOPEX Business Process Analysis
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journey provides an overview of customer expectations, painpoints encountered,
and the resources used at each step of the journey. Last but not least, touchpoints,
which are the points of interaction between the customer and the company, are
used to measure and improve overall customer satisfaction.

A customer journey is used to describe and organize all interactions
between the enterprise and a persona for a given result.

A persona corresponds to a customer segment targeted by the
experience of the client journey. The resources implemented to give
customers the ability to interact with the enterprise and its
environment, to acquire the expected results, are supported by the
interaction channels.

Representing a customer journey will allow you to easily identify these critical
points. HOPEX Customer Journey is used to describe solutions for improvement
and to assess them at different dates.

w  For more details on the description of workspaces, see "The
customer journey", page 125.

Describing the existing organization

The purpose of this step is to describe the org-units in the enterprise, its different
processes, the risks encountered as well as the associated controls.

An org-unit represents a person or a group of persons that

intervenes in the enterprise business processes or information system.
An org-unit can be internal or external to the enterprise. An internal
org-unit is an organizational element of enterprise structure such as a
management, department, or job function. It is defined at a level
depending on the degree of detail to be provided on the organization
(see org-unit type). Example: financial management, sales
management, marketing department, account manager. An external
org-unit is an external entity that exchanges flows with the enterprise.
Example: customer, supplier, government office.

A risk is a hazard of greater or lesser probability to which an
organization is exposed.

A control is a set of rules and means enabling the assurance that a
legal, regulatory, internal or strategic requirement is respected.

This consists of the following tasks:

e "Describing the organization", page 17,
e "Describing processes", page 18,
e "Describing controls and risks", page 22.

Describing the organization

With HOPEX Business Process Analysis the organizational chart shows the
hierarchy of the org-units in the enterprise, their responsibilities with respect to the
processes and specifies the persons associated with each org-unit and on which site.
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Example of organizational chart:
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w  For more information on describing enterprise org-units, see
"Organizational Charts and Responsibilities", page 111.

Describing processes

Describing organizational processes

An organizational process is a set of operations performed by org-
units within a company or organization, to produce a result. It is

depicted as a sequence of operations, controlled by events and
conditions.
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With HOPEX Business Process Analysis, organizational processes are described

in the form of diagrams.
In the example of the purchase request process,

the

organization is represented by the following diagram.

iPurchase

Request

= Purchase Confirmed

=% Process Purchase Request

t Purchasing Assistant { Purchasing Manager

Start

Stock Data

2 Completed Purchase Order >

w  For more details describing an organizational process, see
"Organizational Processes", page 35.

Business process modeling

A business process represents a system that offers products or
services to an internal or external client of the company or organization.
At the higher levels, a business process represents a structure and a
categorization of the business. It can be broken down into other
processes. The link with organizational processes will describe the real
implementation of the business process in the organization. A business

process can also be detailed by a functional view.
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The business process diagram enables representation of product or service offerings
proposed by the enterprise to each of its markets, as well as the processes that
produce these.

Provide Vacations with
Boat Rental

% Boat Rental Customer

[J Flight Ticket Reservation
[ Boat rental

8 Hotel or Guesthouse

B =

Reservation
[ Car rental

Provide Cruises
4 Cruise Customer

[ Flight Ticket Reservation

Cruise Reservation
Hotel Reservation
[ Car rental

w  For more details describing an organizational process, see
"Business processes"”, page 69.

Describing value streams

LU A value stream is an end-to-end collection of Value Stages that

creates an outcome for a customer, who may be the ultimate customer
or an internal end-user of the value stream.
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The following diagram presents an example of a value stream:
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. DD, IProduct or Service Deliverg
o
------- d
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Services
m:’
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“Profuct or Service Available
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w  For more details on value stream description, see "Value streams”,
page 77.

Describing application processes

A system process is the executable representation of a process. the
events of the workflow, the tasks to be carried out during the
processing, the algorithmic elements used to specify the way in which
the tasks follow each other, the information flows exchanged with the
participants.

21



HOPEX Business Process Analysisallows you to model the IT system process

implemented when

using an organizational process. This description is made in a

BPMN model detailing the sequence flow of tasks performed when executing the
application in the particular context.

The diagram below represents an example of a purchase request processing
application process.

Analyze Purchase Request

P _Inventory Management P _Supplier Management ® purchasing Management

Start

[In stock] (L

Find requested product Find Suppliers
> o I St
Referenced Products Supplier Data
|Requested]
b
Referenced product i
Stock analysis Compare Price and
> Service £on - Supplier, Contracts
Spare Parts Supplier Data H

L \
» Request

Product in stock

available  Error

Request to make Cancel Request

[> verification

w  For more details describing a system process, see "System
Processes", page 83.

Describing controls and risks

A risk is a hazard of greater or lesser probability to which an
organization is exposed.

A control is a set of rules and means enabling the assurance that a
legal, regulatory, internal or strategic requirement is respected.

The HOPEX Business Process Analysis repository covers all enterprise
resources, from global value streams to IT resources. The HOPEX Risk Mapper
approach enables business and IT managers to guarantee traceability of compliance
controls via application layers, data and infrastructures.

w  for more information, see HOPEX Control and Risk.

Managing organizational transformation

The purpose of thi

s step is to prepare for the transformation of your enterprise.

HOPEX Business Process Analysis



Introduction
The HOPEX Business Process Analysis method

Given the products in the Suite HOPEX available to you, you can manage the
transformation of your enterprise in a number of different ways:

e "Using portfolios", page 23

e "Managing Action Plans", page 23

e "Describing implementation projects", page 23

e "Documenting projects implemented in SAP", page 23

Using portfolios

A portfolio enables representation of all investments of an

enterprise (or department) necessary to carry out changes required to
achieve strategic objectives. It comprises a set of initiatives to be
compared based on comparison criteria associated with the portfolio.

By means of portfolio management, HOPEX Portfolio & Planning enables
planning over time of development of information systems, organizations and more
generally all enterprise architecture.

Depending on the HOPEX Suite of products you have available, different object
types can be described in enterprise portfolios. With HOPEX Business Process

Analysis, you can work with process portfolios.

By selecting Transformation > Portfolios, you can access the features available
with HOPEX Business Process Analysis to manage portfolios.
w  For more information, sce HOPEX Portfolio & Planning.

Managing Action Plans

An action plan comprises a series of actions, its objective being to
reduce risks and events that have a negative impact on company
activities.

HOPEX Business Process Analysis allows you to specify, implement and follow
up action plans defined for remediating, for example, a process or a customer
journey.

By selecting Transformation > Action Plan, you can access the facilities available
with HOPEX platform to describe and manage action plans.

w  For more information on use of action plans, see "Action Plans with
HOPEX Business Process Analysis", page 171.

Describing implementation projects

A project consists of a set of tasks entrusted to a team, which
transforms a system or part of a system with the aim of achieving a
given objective.
By selecting Transformation > Projects, you can access the facilities available
with the HOPEX platform to manage projects.

w  For more details on managing projects, see the "Projects in
HOPEX" chapter in the HOPEX Common Features guide.

Documenting projects implemented in SAP

By selecting Transformation > Solution Manager, you can access the features
proposed with the HOPEX SAP Blueprint product.
w  For more information, see HOPEX SAP Blueprint.

23



HOPEX BUSINESS PROCESS ANALYSIS DESKTOP
PRESENTATION

The menus and commands available in HOPEX Business Process Analysis
depend on the profile with which you are connected.

w  For more details on using the Web platform for HOPEX solutions,
see the HOPEX Common Features guide.

w  Desktops described in this guide are accessible only to Web desktop
users.

Connecting to HOPEX Business Process Analysis

To connect to HOPEX Business Process Analysis, see in HOPEX Common
Features guide, chapter"The HOPEX Web Front-End Desktop" and "The HOPEX
Windows Front-End Desktop".

HOPEX Business Process Analysis Desktop Presentation

The menus and commands available in HOPEX Business Process Analysis
depend on the profile with which you are connected.

w  For more details on using the Web platform for HOPEX solutions,
see the HOPEX Common Features guide.

w HOPEX Business Process Analysis is mainly intended for web
users. Desktops described in this guide are accessible to Web desktop
users.

Presentation of space common to all profiles

All users, except users connected with the Process Contributor profile, have
access to the HOPEX Business Process Analysis desktop and the following panes:
Home: provides quick access to user objects.
Dashboards: displays the list of indicators required to steer objects
such as processes, applications or org-units.
e My Work: displays the tasks assigned to the user.
e Design: gives access to all the process models described.
e Customer Journey: gives access to the mapping of the customer
journey if you have the HOPEX Customer Journey module.
w  For more details, see "The customer journey", page 125.

e Reports: accesses all reports, improving understanding of terms and
their use.

w  For more details, see "HOPEX Business Process Analysis Reports”,
page 175.
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Presenting the Process Manager space

In addition to the panes offered in standard mode to all HOPEX Business Process
Analysis desktop users, the users connected with the Process Manager profile
have access to the following panes:

= e a-~ Last Saved 11/28/201917:11 | 2® f.‘ﬂi @ @

0B & R

5% HOPEX
BUSINESS PROCESS ANALYSIS

All Customer Joumeys

Al Org-Units

All Regulation Fram...

The Environment pane

The Environment pane provides access to the following menus.
e Libraries, to access the management features for libraries.
w  For more details, see "Preparing the Work Environment", page 16.

e Organization, to access the main objects processed with the HOPEX
Business Process Analysis solution.

The Design pane

The Design pane provides access to the following menus.
e Organization, for describing the org-units of the organization.

w  For more details, see "Organizational Charts and Responsibilities”,
page 111.

e Process, for describing the business and organizational processes of the
organization.

w For more details, see "Organizational Processes", page 35 and
"Business processes"”, page 69.

e Controls & Risks, for accessing the risk management features offered
with the HOPEX Risk Mapper product.

w  For more information, see HOPEX Risk Mapper.
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The Transformation pane

The Transformation pane provides access to the management features of
transformation projects and offers the following menus.

e Planning, to access the portfolio management features offered with the
HOPEX Portfolio & Planning product.

w For more information, see HOPEX Portfolio & Planning.

e Corrective Action Plans, to describe and manage the action plans
linked to the transformation of processes.

w  For more details, see "Action Plans with HOPEX Business Process
Analysis", page 171.

¢ Implementation Projects, to access and manage transformation
projects.

w  For more details on managing projects, see the "Projects in
HOPEX" chapter in the HOPEX Common Features guide.

e Solution Manager, to access the features offered with the HOPEX SAP
Blueprint product.

w For more information, see HOPEX SAP Blueprint.

The Campaign Management pane

The Campaign Management pane provides access to the creation and
management functionalities.

w  for more details, see "Assessments With HOPEX Business Process
Analysis", page 161.

The Administration pane

The Administration pane provides access to the user management features. The
rights of different users on objects of imported libraries depend on their assigned
profiles.

w  For more information on creation of users and assignment of

profiles, see the chapter "Managing Users" in the HOPEX
Administration guide.

Presenting the Functional Administrator space

In addition to the panes offered in standard mode to all HOPEX Business Process
Analysis desktop users, the users connected with the Process Functional
Manager profile have access to the same functions as users connected with the
Process Manager profile:

w  For more details, see "Presenting the Process Manager space”,
page 25.
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HOPEX Business Process Analysis Desktop Presentation

Presenting the Process Designer space

In addition to the panes offered in standard mode to all users of the HOPEX
Business Process Analysis desktop, the Process Designer has access to the
Design and Transformation panes.

4 Accueil

B Tableaux de bord
o

[El Mon travail
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4= Parcours client - s = TN N = d
' Cconception E
{21 Transformation 3 7 3 2
E) Rapports ;

s les processus organisationnels Tous les persona

Tous les risques

The Design pane

The Design pane provides access to the following menus.
e Organization, for describing the org-units of the organization.

w  For more details, see "Organizational Charts and Responsibilities”,
page 111.

¢ Process, for describing the business and organizational processes of the
organization.

m  For more details, see "Organizational Processes”, page 35 and
"Business processes"”, page 69.

Introduction
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The Transformation pane
The Transformation pane provides access to the management features of
transformation projects and offers the following menus.

e Corrective Action Plans, to describe and manage the action plans
linked to the transformation of processes.

w  for more details, see "Action Plans with HOPEX Business Process
Analysis", page 171.

e Implementation Projects, to access and manage transformation
projects.

w For more details on managing projects, see the "Projects in
HOPEX" chapter in the HOPEX Common Features guide.

e Solution Manager , to access the features offered with the HOPEX SAP
Blueprint product.

w  For more information, see HOPEX SAP Blueprint.

Presenting the Process Designer space (basic)

Users connected with the Process designer (basic) profile have access to the
panes offered in standard mode to all users connected with the Process Designer
profile. Only the Transformation pane is not available to them.
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Presenting the Process Contributor space

In addition to the panes offered in standard mode to users of the HOPEX Business
Process Analysis desktop, the Process Contributor has access to the Design
and Transformation panes.

Users connected with the Process Contributor profile have access to the Home,
My Work, Design and Reports panes offered in standard mode to all users
connected with the Process Designer profile.
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Presenting the Process Observer space

Users connected with the Process Observer profile have a reading access to the
objects offered in the HOPEX Business Process Analysis desktop.
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ABOUT THIS GUIDE

This guide presents how to make best use of HOPEX Business Process Analysis
to assure efficient management of your modeling projects.

Guide Structure

The HOPEX Business Process Analysis guide comprises the following chapters:

"Organizational Processes", page 35 presents how to define participants
and the sequence flow of operations of an organizational process.
"Business processes", page 69 presents how to specify enterprise
product and service offerings, and the breakdown of the processes
producing these.

"Value streams", page 77 describes the representation of enterprise
value streams in terms of activities. It enables freeing from the existing
organization to imagine new organization solutions for your processes.
"System Processes", page 83 describes the IT process required for
implementation of an organizational process by sequencing tasks
executed.

The "Conversations", page 97 chapter explains how to model
conversations between process architecture components.
"Organizational Charts and Responsibilities", page 111chapter describes
how to create an enterprise organizational chart and how to define
responsibilities of persons and org-units.

The "The customer journey", page 125 chapter is used to represent the
acquisition process of a product or a service by a specific customer.

The "Assessments With HOPEX Business Process Analysis", page 161
chapter describes how to assess the execution and performance of
business and organizational processes with HOPEX Business Process
Analysis.

The "Action Plans with HOPEX Business Process Analysis", page 171
chapter describes how to use the action plans with HOPEX Business
Process Analysis.

"HOPEX Business Process Analysis Reports", page 175 presents reports
proposed by HOPEX Business Process Analysis to assist users at each
step of architecture description and analysis projects.
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Additional Resources

This guide is supplemented by:

e The HOPEX Common Features guide describes the basic functions
common to HOPEX products and solutions.

w ]t can be useful to consult this guide for a general presentation of
the interface.

e The HOPEX IT Portfolio Management guide, which describes
functions proposed to manage all your applications.
e the HOPEX Power Supervisor administration guide.

e More advanced technical functions are described in the HOPEX Power
Studio guide.

Conventions used in the guide

w  Remark on the preceding points.
Definition of terms used.

© A tip that may simplify things.

Jﬂ/ Compatibility with previous versions.
é& Things you must not do.

I Very important remark to avoid errors during an operation.

Commands are presented as seen here: File > Open.

Names of products and technical modules are presented in bold as seen here:
HOPEX.
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ORGANIZATIONAL PROCESSES

The aim of this chapter is to familiarize you with HOPEX Business Process Analysis: it introduces
a few features of the software dedicated to organizational process modeling activities.

m  For more details on management of your desktop, and of diagrams
and objects, see the HOPEX Common Features guide.

An organizational process is a set of operations performed by org-units within a company or
organization, to produce a result. It is depicted as a sequence of operations, controlled by events
and conditions.

With HOPEX Business Process Analysis, an organizational process representation is based on
the standard BPMN (Business Process Modeling Notation) offering notation easily used by all
participants concerned.

The points covered here are:

Organizational Process Example
Managing an Organizational Processes
Defining Participants

Creating Operations

Describing Operations Sequence Flows
Defining Message Flows

Defining Process Events

Using Shared Objects

Using Gateways

SN N N NENENRN
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ORGANIZATIONAL PROCESS EXAMPLE

In the example of the purchase request process, the organization is represented by
the following diagram.

=% Process Purchase Request

t Purchasing Assistant { Purchasing Manager

Start

Purchase

@ T, Request | _ Stock Data
-5 Rejected Purchage ~
Request

Completed Purchase Order >

Purchase Confirmed

The purchase request is received by a purchasing assistant,
who enters the request and submits this for the approval of
the purchasing manager.

If the request is rejected, the purchasing manager informs
the requester.

If the request is approved, the assistant sends a completed
request to buyers responsible for issuing the order, and
sends a confirmation message to the requester.

This chapter explains how to use the main objects presented in this diagram.

e The frame containing the different components represents the
organizational process described by the diagram. Its name "Process
Purchase Request" appears in the box at top left.

An organizational process is a set of operations performed by org-
units within a company or organization, to produce a result. It is

depicted as a sequence of operations, controlled by events and
conditions.

e The participants in execution of this process are org-units. They are
represented in columns for reasons of diagram readability. For more
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Organizational Process Example .

details, see Defining Participants.

A participant (org-unit) enables representation of org-units
assigned to execute a group of process operations.

An org-unit represents a person or a group of persons that

intervenes in the enterprise business processes or information system.
An org-unit can be internal or external to the enterprise. An internal
org-unit is an organizational element of enterprise structure such as a
management, department, or job function. It is defined at a level
depending on the degree of detail to be provided on the organization
(see org-unit type). Example: financial management, sales
management, marketing department, account manager. An external
org-unit is an external entity that exchanges flows with the enterprise.
Example: customer, supplier, government office.

The different steps in this process are operations. Organization of these
steps is described by sequence flows.

L An operation is an elementary step in an organizational process

executed by an org-unit. It cannot be broken down. An operation can be
industrial (manufacturing a component), logistical (receiving a
delivery), or can involve information processing (entering an order).

Message flows enable representation of data or information circulating
between a process and the exterior.

A message flow represents circulation of information within an
exchange contract. A message flow transports its content.
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MANAGING AN ORGANIZATIONAL PROCESSES

This section explains how to describe your work context and describe an
organizational process.
An organizational process is a set of operations performed by org-
units within a company or organization, to produce a result. It is

depicted as a sequence of operations, controlled by events and
conditions.

Creating an Organizational Process

To create an organizational process from the Design navigation pane:
1. Select Processes > Organizational Processes.
2. In the My Organizational Processes tab, click New.
The Organizational Business Process dialog box appears.
3. Enter the name of the organizational process.
4. Click OK to close this dialog box.
The organizational process appears in the list.

Managing an Organizational Process Diagram

An organizational process diagram can be created and updated in tabular input
mode.
~

w  For more information on using tabular input, see the "Entering a
diagram in tabular mode" in the HOPEX Common Features guide.

Creating an Organizational Process Diagram

To create an organizational process diagram:
1. Right-click the process name and select New > Organizational
Process Diagram.
The entry mode selection dialog box opens.

2. Click No to open the diagram editor.
The diagram opens in the edit area. You are now in the HOPEX graphic
editor. The frame of the described organizational process appears in the
diagram.

Accessing an Organizational Process Diagram

To access an organizational process diagram:
1. Right-click the process to open its pop-up menu.

HOPEX Business Process Analysis



2. Select Organizational Process Diagram.
The diagram opens in the edit area.

w If the process does not have a diagram, you can create it by
clicking New > Organizational Process Diagram in its pop-up menu.

Organizational Processes
Managing an Organizational Processes

Organizational Process Diagram initialization

By default, with  HOPEX Business Process Analysis, the BPMN diagram is
initialized with the current process, represented by a frame; Start and End events
are added in the frame as well as input and output gates.

If the organizational process is represented in a higher level diagram, the diagram
is initialized taking into account participants and flows that are represented in the
higher level diagram. A note provides the name of the diagram from which the new

diagram has been initialized.
w  After reading this note, you can remove it.

Example of an Organizational Process Diagram
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Accessing organizational process properties

The properties of the different business processes available in HOPEX Business
Process Analysis depend on the profile with which you are connected and the
products that you possess.

Organizational Process characteristics

The Characteristics page of the properties window of a process is divided into
different sections:
e The Identification section of the properties window for a process

provides access to:

e its Name,

e its Owner, by default on creation of the process, it is held by the

default library.
w  For more details on libraries, see Preparing the Work Environment.
e jts Code,
e its update State,

w  For more details on process statuses, see Organizational process
review workflow.

e the text of its Description.

e The Responsibilities section enables to identify all persons concerned
by the process description depending on their role.

e The Components section enables to access all organizational Processes
and operations that that contribute to the organizational process
execution.

e The System Used section enables to access the list of elements used by
the process.

w  For more details, see Modeling the Systems Used.

e The Details section enables access to process type, for more details, see
Task type.

e The Controls et Risks section enables business and IT managers to

guarantee traceability of compliance controls via application layers, data
and infrastructures.

A risk is a hazard of greater or lesser probability to which an
organization is exposed.

A control is a set of rules and means enabling the assurance that a
legal, regulatory, internal or strategic requirement is respected.
w  For more details on controls, see the HOPEX Risk Mapper guide.
e The Attachments section enables to access all documents dedicated the
described process.
e The Word Report section enables creation of word reports of the
described process.
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The property pages of an organizational process

With HOPEX Business Process Analysis a process is described by the following

properties:

the Assessment page that is used to access the different possibilities
for assessing the process.

w  For more details, see Assessments With HOPEX Business Process
Analysis.

Action Plans page, used to access the action on the process.

w  For more details, see Action Plans with HOPEX Business Process
Analysis.

Quality page, allows to enter quality characteristics specific to the
process.

w  For more details, see Managing Quality.

Reports page, used to access the different reports available on the
process.

w  For more details, see HOPEX Business Process Analysis Reports.

SolMan Manager and SolMan History pages, used to access the
facilities offered with the HOPEX for SAP Solution Manager 7.2
product.

w  For more information, sece HOPEX for SAP Solution Manager
7.2.
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DEFINING PARTICIPANTS

A participant defines a partition of the actions of a process that will
be assigned to a same agent.

A participant enables:

e Assignment of a group of operations to one or to several enterprise org-
units.

e Representation of a unit external to the process with which the process
communicates by means of message flows.

Organizational process participants may be associated to different object types, but
org-units are privileged.

An org-unit represents a person or a group of persons that
intervenes in the enterprise business processes or information system.
An org-unit can be internal or external to the enterprise. An internal
org-unit is an organizational element of enterprise structure such as a
management, department, or job function. It is defined at a level
depending on the degree of detail to be provided on the organization
(see org-unit type). Example: financial management, sales
management, marketing department, account manager. An external
org-unit is an external entity that exchanges flows with the enterprise.
Example: customer, supplier, government office.

m  You can also use the Assignment section of the Characteristic
property page of a participant to connect new or existing objects of
different types to the participant.

Using Participants

A participant defines a partition of the actions of a process that will
be assigned to a same agent.

Example of participants

e
| I |

Creating a Participant (Org-Unit )

A participant (org-unit) enables representation of org-units
assigned to execute a group of process operations.

Org-units, either new or already created, can be assigned to participants of a
process.

Example: The "Analyze Purchase Request" operation in the
"Process Purchase Request" process, handled by the
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Purchasing Manager, is assigned to the Purchasing Assistant
when the manager is absent. To represent this, we assign
org-units "Purchasing Manager" and "Purchasing Assistant"
org-units to the same participant.

To create a participant (Org-Unit) in an organizational process diagram:

1.

Click the arrow at the right of the participant (org-unit) B button in
the insert toolbar.
Click within the organizational process frame.
The Creation of Participant- Assignement wizard opens.
In the Org-Unit field, select the org-units you wish to assign to the
participant.
Click the Next button.
The Creation of Participant - Assignment wizard allows you to modify
the list of selected actors.
Click OK.
The participant is positioned in the diagram. If you have not specified a
name, it will carry the name of the assigned org-unit.
© 7o hide the name of the participant, open its pop-up menu and
select Shapes and Details. In the tree on the left, click the "Short

Name" folder, then in the Content tab, clear the Short Name check
box.

Creating a Participant

To create an org-unit participating in execution of a process:

1.

In the diagram insert toolbar, click the Composite Participant (Org-

Unit) > Participant 8| button.

Click in the diagram within the organizational process frame.

The participant appears in the diagram.

Click the "Participant" name and press key <F2> to modify the name of
the participant.

Assigning an org-unit to a participant

Org-units, either new or already created, can be assigned to participants of a

process.

Example: The "Analyze Purchase Request" operation in the
"Process Purchase Request" process, handled by the
Purchasing Manager, is assigned to the Purchasing Assistant
when the manager is absent. To represent this, we assign
org-units "Purchasing Manager" and "Purchasing Assistant"
org-units to the same participant.

To assign an org-unit to a participant:

1.
2,

Open the Characteristics property page of the Participant.
In the Assignment section, click the Connect button.
A wizard opens.
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3. Select Org-Unit and select Propose.
A list of proposed org-units is displayed.

4. Select the org-unit you wish to assign to the participant, "Purchasing
Assistant” in the example, and click OK.
The assignment appears in the properties dialog box of the participant..

Conditioning the assignment of an object to a participant

To condition participation of an org-unit:
1. Open the Characteristics property page of the Participant.
2. In the Assignment section, select the line of the org-unit of which you
wish to condition assignment.
3. Click in the Conditioning column.
4. Enter the text of the condition.

Assignment:

® New &P Connect = I Reorganize B ® =@ @
T
o

«®» Account Manager

o) If Manager absent

5. Click OK to close the properties of the participant.
The text of the condition appears between brackets alongside the name
of the org-unit in the participant title bar.

Positioning a Participant in a Swimlane

The swimlane is a tool that enables graphical presentation of certain diagram types.
Objects arranged in swimlanes automatically take the same dimensions and are
aligned.

To create a swimlane and place in it the participants you have just created:

1. In the insert tool bar, click the Vertical Pool El button.

2. Click on the diagram.
The swimlane is created.

3. Drag the participant into the swimlane holding the mouse button down.

HOPEX Business Process Analysis



Organizational Processes
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4. Release the button when the swimlane frame and the described process
are highlighted.

The swimlane adapts to the size of the participant.

w  For more details on swimlanes, see "Using swimlanes" in "Handling
HOPEX MEGA Objects" in HOPEX Common Features.
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CREATING OPERATIONS

An operation is an important step in an organizational process. For steps requiring
greater detail, organizational processes can be used.

Creating an Operation on a Participant

To create an operation and connect it to the participant responsible for its execution:

1. Click on the Operation B button of the Insert toolbar.
2. Click in the diagram within the shape of the participant concerned.
The operation is automatically created.
To assign an operation to another participant:
) Select the operation and move it from one participant to the other.

w When positioned, the operation is disconnected from the initial
participant and reconnected to the new participant executing the
operation.

Operations example

=% Process Purchase Request m

Start

@)

Enter Purchase
Request
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Calling an Organizational Process in an Operation

You can create an operation that calls an organizational process. This functionality
enables, for example, replacement of the process called by another process without
disturbing description of the main process.

To create an operation that calls an organizational process:

1. Click the arrow at the right of the Operation B button and select
Referenced Organizational Process.

" v
Al

B Operation

. @ Referenced Organizational Prc

~

2. Click in the diagram within the shape of the participant responsible for its
execution.
A creation dialog box opens.

3. In the Organizational Process field, enter the name of the process.

In our example, "Process Purchase Request" could be
replaced by "Process Urgent Purchase Request".
w By default, the operation carries the same name as the
organization process called.
4. Click OK.
The operation appears in the diagram with the name of the organizational
process.

Modeling the Systems Used

A system used during the execution of a step of a process

represents what is necessary to realize this step. It can be an
application or an IT service, or any other non IT resource, or more
generally a functionality.

A System Used can be of several types:
e an IT service,

An IT service is a software component of an application, that can’t
be deployed alone and that realizes a sub-set of the functionalities of
this application either for end users of this application or inside the
application (or another application). This includes batch programs.

e an application,

An application is a software component that can be deployed and
provides users with a set of functionalities.

e a functionality,

A functionality is a service required by an org-unit in order to
perform its work. This functionality is generally necessary within an
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activity in order to execute a specific operation. If it is a software
functionality, it can be provided by an application.

® aresource.

L) A resource is a means used to perform certain actions.

System used Example

We can define a new organizational process for processing of urgent purchase
requests, in which responsibilities of the purchasing assistant are extended.
However, the assistant is using an application.

off Process purchase order

Stant

®PProcess Purchase Request

System Used

quulpmeni Purchasing

If product in

stock
MProcess purchase order

"Process Purchase Request" Organizational Process

The purchasing department begins by analyzing the purchase
request. Is product in stock? A request for availability is
put forth.

To analyze the purchase request and send the order, the
purchasing assistant requires data on stock levels. He will
have access to the "Equipment Purchasing" application.

Creating a System Used in an organizational process diagram

w  You can see the systems used by the operations by selecting
"System used" in the window opened from the "Views and Details” @
button.
To create a system used representing the use of the application by the
organizational process:

1. Click the arrow at the right of the System Used button and select
Application Used.

2. Click on the diagram.
A creation dialog box opens.

3. In the Application field, select the applications you want to use.
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Click OK.
The system used is positioned in the diagram.

Use the link button to connect the system used you have created to an
organizational process or an operation.
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DESCRIBING OPERATIONS SEQUENCE FLOWS

A sequence flow is a directional link that represents the chronological organization
of the different processing steps.

A sequence flow is used to show the order in which steps of an

exchange contract will be performed. A sequence flow has only one
source and only one target.

Creating Sequence Flows

To create a sequence flow between two operations::

1. Click the Sequence Flow — button.

2. Click the sender operation and draw a link to the recipient operation.
A dotted line link indicates the path taken by the graphic link.

w  Several paths are possible: you need only move the cursor in the
recipient operation frame.

Moving Sequence Flows

You may need to change the predecessor or successor of a sequence flow.
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To move a sequence flow:

1. Click the sequence flow.
The two link ends are marked by squares.

2. Holding the <Shift> key down, position the mouse on the square at the
end you wish to move.
A reel appears when you are correctly positioned on the link end.

3. Still holding the <Shift> key down, click the square and, holding the

mouse button down, move it to its new predecessor or successor before
releasing the mouse button.

The link appears in its new position in the diagram.

Defining a Condition on a Sequence Flow

Specifying that a sequence flow is conditionned

To define that a sequence flow is conditioned:
1. Right-click the sequence flow and select Sequence Type >
Conditioned.

2. Click the sequence flow and press key <F2> to add a comment if
necessary.

The text associated with the condition appears on the link which then
takes form —1>,

m  You can also access to the conditions of the sequence flow from the

Characteristics property pages of the sequence flow. The comment
appears in the Predicate field.

- Characteristics ¥

— Identification

Name: Organizational Process-2-->Organizational Process-3
Owner: Organizational Process w | Organizational Process-1
Sequence type:* | Conditioned »

Predicate:
T

A predicate can be associated with a condition. It allows you to indicate what
happens in the different statement branches of the condition. If a predicate is
used alone, it defines the condition that must be satisfied in order to perform
an action.

Defining a Sequence Flow

If several conditioned sequence flows are from the same operation, you can specify
that one of these should be used as default. For example, having completed the
"Enter Purchase Request" operation, the assistant always executes the "Finalize

Request" operation, except if the request is not acceptable and is below a given
amount.
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To define that a sequence flow is used by default:
) Right-click the sequence flow and select Sequence Type > Default.

The link then takes form ~—.
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DEFINING MESSAGE FLOWS

The content of message flows exchanged with the exterior can be specified.

=] Process Purchase Request

Start

O

wiPurchase

wiPurchase Confirmed

Creating a Message Flow With Content

You can specify the content of message flows exchanged between a process and its
environment directly at flow creation.

A message flow represents circulation of information within an
exchange contract. A message flow transports its content.

To create a message flow and its content:

1. In the diagram insert toolbar, click the Message Flow button arrow,
option Message Flow With Content

g - Message Flow With C
P v

-+ Message Flow
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2. Click the first object representing the start step, and, holding the mouse
button down, draw a line to the object representing the next step.
The Creation of Message Flows With Content dialog box opens.

3. In the Content drop-down list, select the content you wish to associate
with the flow.
The message flow is displayed with its content in the diagram.

w  You can associate several contents with the message flow. For
more details, see Creating a Message Flow With Content.

Defining Message Flow Content

A message flow represents circulation of information within an
exchange contract. A message flow transports its content.
To define content of a message flow:

1. Open the Characteristics property page of the Message Flow.
2. Click the arrow at the right of the Content field and select Connect
Content.
The selection dialog box appears, with a list of contents proposed for the
message flow.
3. Select the content name and click OK.
w A content can be used by several message flows since it is not
associated with a sender or recipient.

The name of the content appears in the diagram.
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DEFINING PROCESS EVENTS

The events enabling representation of facts occurring during process execution.

An event represents a fact or an action occurring in the system,
such as updating client information. It is managed by a broker. An
application indicates that it can produce the event by declaring that it
publishes it. If an application is interested in an event, it declares that it
subscribes to the event.

Events can be used:

e Within a process to define facts internal to the process.
e Qutside a process to describe causes and effects of events of the process
depending on its use context.

The different event types are presented in this section.
v Defining an event

v Connecting Events to Sequence Flows
v/ Accessing Preceding or Succeeding Processes

Defining an event

Event natures

The nature of the event enables specification of its position in the processing.

e Start: start of the processing sequence

e Catching: awaiting an event (arrival of a message, signal, etc.) before
continuation of processing

e Throw: triggering an event (message, signal, etc.) and continuation of
processing

e End: end of processing
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Event types

Event type enables specification of what will trigger the event and what will be
triggered by the event.

None the trigger is not specified, generally at the start or end of a
process

Message: the event is receiving or sending messages

Timer: the event is triggered by a timer

Error: the event is triggered by errors or throws errors that cause
interrupt of the process

Escalation: the event is triggered by an error or throws a non-critical
error

Cancel: the event reacts to cancellation of a process step or triggers
cancellation

Compensation: the event handles or triggers compensation of a failed
process

Conditional: the event is triggered by a condition

Link: the event is used to connect two sections of a process

Signal: the event waits for a signal or throws a signal. One signal
thrown can be caught multiple times

Finish: the event indicates that all process steps should be immediately
ended without compensation or event processing

Multiple: the event has multiple triggers

Multiple: the event has several simultaneous triggers
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Event type and nature combinations

The following table presents valid combinations of event type and nature.

START INTERMEDIATE EMD
-
_ _ '}E _ _
BB Z B TR

Mane

tMezzage
Tirner
Error

E zcalation

Cancel

Compensation

Conditional
Link.
Signal
Teminate
tuiltiple
Farallel multiple @ i ':i;_,t‘

Current process interruption
The current process may be interrupted when an event occurs. This characteristic
of the event is specified in Interruption which can be one of the following values:

e Interruption
¢ Non interruption
w By default the event interrupts the current process.
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Creating Events

You can directly create the most frequently used events:

1. Click the Event button in the toolbar and select from the predefined
nature events the nature that interests you.

LA (| Evénement

i

v . O Début @
I O Fin

« (@ Temporel

2. Click on the diagram.
The new event appears in the diagram.

To create an event with a specific nature or type:

1. Click the Event button I@ in the insert toolbar.
2. Click on the diagram.

The Create Event dialog box opens.

Enter the name you want to give the event.
Select the nature of new event.

o

w By default, the nature is Catching.

5. Click Next and select the type of event you wish to create.
w By default the type is None.

6. Click OK.

The new event appears in the diagram. The shape of the event respects
conventions linked to its type and nature.

w By default the event is interruption.

Connecting Events to Sequence Flows

In a given context, a process can be connected to another process by a sequence
flow.

Process Purchase
Request
(+]
8 Process Purchase
Order
+|

In the example above, the "Process Purchase Request"
process precedes the "Process Purchase Order" process.
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Displaying external processes

In the diagram describing the process, the preceding process can be displayed.

Start

®Process Purchase request l

In the diagram that describes the "Process Purchase Order"
process, the "Process Purchase Request" process that
precedes it is shown.

To do this, it is necessary to specify the event involved in the sequence flow:
1. Open the Characteristics property page of the sequence flow.
2. In the Triggered Event section, click the Connect button.
The query dialog box appears.
3. Find Possible Triggered Events.
The list displayed proposes start events or catching events of the
successor process.
w  The successor process is generally triggered at its start and

normally has only a single start event. This start event is therefore
generally the event that interests you.

4. Select the event corresponding to the sequence flow.
5. Click Connect.

If you open the organizational process diagram containing this event, you can view
the process that precedes it. For more details, see Accessing Preceding or
Succeeding Processes.

You can similarly select the triggering event of the previous process. In this case,
end events or throw events from the preceding process will be proposed.

Accessing Preceding or Succeeding Processes

In the following example, the "Process Purchase Order" organizational process is
activated after processing of the purchase request, and itself activates the "Make
Available" process.
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To show, at events level, the processes preceding and succeeding the described
process, you must:

e Specify the sequence flows in which the events are involved. For more
details, see Connecting Events to Sequence Flows.
e Activate the views enabling access to context-sensitive information.

=L Process purchase order

Start

®PProcess Purchase request

Y Thre
Purchase Prodyict available in stock
Request S ieiieieiieileieielk ikl 1 -
FRecpivd Goods a

To activate the context-sensitive view:

1. Click the Views and Details ® button in the diagram toolbar.
2. Select the View External Processes check box.
3. Click OK.

Attaching an Event to a Process

To attach an event to a process:

1. Click the event and hold the mouse button down.
2. Position the event on the border of the process.

To detach the event from the process border:
} Right-click the event and select Detach.
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USING SHARED OBJECTS

In an organizational process diagram, a data object can be used to represent the
fact that data or objects (correspondence, raw materials, finished products, etc.)
are in stock awaiting use.
A data object is used to explain how documents, data, and other
objects are used and updated during the process. A data object can

represent an electronic document, or any other type of object,
electronic or physical.

Stock Data

In this example, the shared object "Stock Data" is
represented with an open head arrow since it is used by the
"Analyze Purchase Request" process without having been
produced by one of the processes represented in the
repository.

Creating a Data Object

To create a data object:

1. Click the Data Insertion Jlj button in the diagram insert toolbar.
2. Click in the diagram to position the object.
The Create Data Object dialog box appears.
3. Click the arrow at the right of the Content field and select the content
that interests you.
w A content can be used by several data objects.

4. Enter Data Object State if required.
w By default the data object carries the same name as its content.
The state appears between brackets.
5. Click OK.
The data object appears in the diagram.

Describing a Data Object

To specify that a shared object corresponds to an object collection:
1. Open the Characteristics properties page of the data object.
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2. Click the arrow at the right of the Collection box, and select Yes.
The shared object then takes the following form:

Information necessary for execution of operations can be consulted or updated in
the data objects.

To indicate that information was obtained from a data object, for example that stock
data used by the "Analyze Purchase Request" operation was obtained from the
"Stock Data" data object:

} Click the link J] button in the insert tool bar to link the "Stock Data" to

the "Analyze Purchase Request" operation.
w A data object is represented by an open head arrow if it is read by a
process without having been updated by one of the processes in the
repository.
w A data object is represented with a solid head arrow if it is updated
by a process and not read by any of the processes in the repository.

Associating a data object with Sequence Flow

You can specify that the content of a shared object is sent at sequencing of two
operations.
For example, a shared object "Purchase Request" can be sent
between the operations "Enter Purchase Request" and
"Finalize Request".

A data object is used to explain how documents, data, and other
objects are used and updated during the process. A data object can
represent an electronic document, or any other type of object,
electronic or physical.

To simultaneously create a sequence flow and a data object:
1. Click the Sequence Flow button arrow, option Sequence Flow With
Data Object.

=% — Sequence Flow

LN
—— % Sequence Flow with Data Object

2. Click the operation representing the start step, and, holding the mouse
button down, draw a line to the operation representing the next step.
The Creation of Sequence Flow -Data Object dialog box opens.

3. In the Content drop-down list, select the content you wish to associate

with the flow.
The sequence flow and its content are displayed in the diagram.
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Using Data Stores

Objects that are shared, supplied or used in processing can be stored in a data store.

A data store provides a mechanism to update or consult data that
will persist beyond the scope of the current process. It enables storage
of input message flows, and their retransmission via one or several
output message flows.

In the example below, data relating to suppliers is represented by the "Supplier
Data" data store.

Provider Data

Creating a data store

To create a data store of processes:
1. Click the Data Store button in the insert toolbar.

w If the button is not visible by default, click the diagram Views and
Details button and select the "Data Stores" view.

2. Click in the diagram to position the object.
The Add Data Store dialog box appears.

3. Enter the name of the Process data store.
4. Click OK.
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USING GATEWAYS

The following example presents a case where continuation of processing is
conditioned: following analysis of a purchase request, the process either ends, or an

order is sent to a supplier.

End )
If product in

stock
MiProcess purchase order

To specify that several processing steps are accessible following a particular
processing step, you can use a gateway.

Gateways are modeling elements that are used to control how
sequence flows interact as they converge and diverge within a process.

w  Conversely, you can also use a gateway to indicate that a particular
processing step is available from several processing steps of a process.

For more information on gateways, see System Process Gateways.
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BUSINESS PROCESSES

This chapter presents how to describe products or services provided by the enterprise to its
customers.

The business process diagram enables representation of product or service offerings proposed by
the enterprise to each of its markets, as well as the processes that produce these.

The points covered here are:

v/ Managing Business processes
v Representing Product Offerings
v Representing Process Contextualization
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MANAGING BUSINESS PROCESSES

Creating a Busines

To create
1.
2.
3.

4,
5.

A business process represents a system that offers products or
services to an internal or external client of the company or organization.
At the higher levels, a business process represents a structure and a
categorization of the business. It can be broken down into other
processes. The link with organizational processes will describe the real
implementation of the business process in the organization. A business
process can also be detailed by a functional view.

s Process

a business process from the Design navigation pane:

Click Process > Business Process.

Select My Business Processes.

Click New.

The Creation of Business Process dialog box appears.

In the Name field, enter the name of the business process.

Click OK.

The business process is created and added to the list of business
processes.

In HOPEX Business Process Analysis, business processes are described by

diagrams.

Creating a Business Process Diagram

To create
)

For more

a business process diagram:
Right-click the process name and select Business Process Diagram.

information on a business process diagram initialization with HOPEX

Business Process Analysis, see Organizational Process Diagram initialization.
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REPRESENTING PRODUCT OFFERINGS

The business process diagram enables representation of product or service offerings
proposed by the enterprise to each of its markets, as well as the processes that
produce these.

4 Boat Rental Customer

Provide Vacations with
Boat Rental

Pj Flight Ticket Reservation
fj Boat rental
B Hotel or Guesthouse
Reservation
Fj Car rental

& Cruise Customer

Fj Flight Ticket Reservation
5 Cruise Reservation
Fj Hotel Reservation
Fj Car rental

In the example above, the enterprise is targeting two
customer segments, those that rent boats, and those to whom
cruises are proposed.

In the case of boat rental, the enterprise also proposes
flight ticket reservation, hotel or guesthouse reservation
and car rental.

In the case of cruises, the enterprise also proposes flight
ticket reservation, hotel reservation and car rental.

Defining Offerings

Offerings are proposed by enterprise business processes to participants outside the
enterprise.

An offering represents the availability of a product or service
supplied by an enterprise through a specific process.

Creating an offering

To create an offering:

1. Click the Offering ¥ button.
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Click the business process and, holding the mouse button down, draw a
link to the participant.

Release the mouse button.

The link representing the offering appears in the diagram.

Defining offering products

A product represents commodities offered for sale, either goods or
merchandise produced as the result of manufacturing, or a service, ie.
work done by one person or group that benefits another.

To specify the detail of offerings of products:

1.

Right-click the offering and select Properties.

The properties windows opens.

Select Characteristics.

In the Product section, click the New button and enter the product
name.

Click OK.

The name of the product appears in the diagram.

w A product can be broken down into component products from its
properties dialog box or from the navigator.

Describing offering implementation

Use the business process diagram of the process that is linked to the offering to
describe the organization and exchanges that are associated with it.

In this way, when you initialize a business process diagram for a process, a
conversation is automatically created for each offering.

w  For more details on business process diagrams, see Creating a
Business Process Diagram.

w  for more details on conversations, see Conversations.

The conversation bears the name of the exchange that is automatically created.

The name of the exchange is that of the offer, or failing this, that of its first product.
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In the example above, a conversation is created to describe
the exchanges that support the airline ticket and hotel
reservation and car rental offerings.
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REPRESENTING PROCESS CONTEXTUALIZATION

The business process diagram enables representation of the context in which the
organizational processes value streams comprising the business process are used.

Operational Purchase Process

Urgent Purchasing - i
Process P Current Maintenance
Equipment { Light Equipment Supplier

Fj Raw materials
[ Spare parts

Ff Boats for rent { Heavy Equipment Supplier

Investment B Cars for rent

Purchase Process

Purchasing business process diagram

In the example above, enterprise purchase processes are
shared between operational purchase processes and
investment purchase processes.

A specific organizational process is defined to process
urgent purchase of car maintenance.

Defining Contextualizations

Contextualizations enable the association of processes between each other.

A contextualization allows specification of the implementation of a
process by another process in a specific context, such as the
geographical location on a site.

Creating a contextualization

To create a contextualization:

1. Click the Contextualization =~ button
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2. Click the process to be implemented and, holding the left mouse button
down, draw a link to the process describing implementation. Release the
mouse button.

The link representing the contextualization appears in the diagram.

Defining context

To specify the context in which a process implements another process:
1. Right-click the contextualization and select Properties.
The properties dialog box opens.
Click Characteristics.
In the Implementation Context section, click the Connect button.
In the window that opens, select the context type, org-unit or site.

Click the Find button @

In the list that opens, select the org-units or sites concerned and click
Connect.

7. Click OK (Web Front-End) or Close(Windows Front-End).

The implementation contexts appear in the diagram.

oo pobd

Launching a Report lllustrating Contextualizations

From a business process, you can launch a report in the form of a matrix to illustrate
contextualizations.

To launch a report illustrating contextualizations:

1. Right-click the business process concerned and select Report
Discovery.

2. In the list of available reports, expand the "Process Analysis" folder.

3. From the "Business Process Contextualization Matrix (BPMN)" report,
click Launch a new report.

4. In the report page, click the name of the report chapter.
A matrix appears.

t

1. Business Process Contextualization matrix

.
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This matrix presents:

e the value streams of the business process in columns
e the organizational processes of the business process in rows

To view a specific context (org-unit, site or product):
) Click the + in the cell.

— Contextualization

“W Purchasing
Department
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VALUE STREAMS

Value streams of the enterprise can be described in the form of functional processes. For example,
when an enterprise operates out of numerous geographical locations, organization of business
process operations can vary significantly between regions.

It is therefore useful to have a summary view, independent of organizational structure, to represent
steps in the value stream connected to enterprise business and common to all organizational
variants.

A functional representation of the value stream also facilitates improvement in enterprise operation.

Indeed, when the operation of each organizational process is represented, this enables local
optimization of each process.

This structure however remains partitioned by existing organizational structures. More significant
changes require a broader view of the value stream, independent of organization. This global view
is represented by the value stream diagram.

HOPEX Business Process Analysis enables the creation and description of enterprise value
streams.

v "Creating a value stream", page 78
v "Representing a value stream", page 79

77



78

CREATING A VALUE STREAM

A value stream is an end-to-end collection of Value Stages that
creates an outcome for a customer, who may be the ultimate customer
or an internal end-user of the value stream.

One option is used to display the value streams.

To activate this option:

1. In the workspace, open the Options window.
2. In the left tree, select Business Process and Architecture Modeling:
3. Select the Value stream Modeling check box.

To create a Value stream from the Design navigation pane:
1. Select Functional Design > All Value streams.
2. Click New.
The Creation of a Value stream window appears.
In the Name field, enter the name of the Value stream.
Click OK.
The value stream is created and added to the list of value streams.

w  The Finish button is grayed if the Name box is not completed.

o

Creating a value stream diagram

To create a value stream diagram
} Right-click the Value stream name and select Value stream Diagram.
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REPRESENTING A VALUE STREAM

w  To display the Value streams, open the Options window and
check that Business Process and Architecture Modeling > Value
stream Modeling is activated.

Value stream representation principles

Highlighting organizational choices

Each enterprise has activities related to its business that must be performed
whatever the organization in place. These activities can be purchasing, sales, sales
administration, manufacturing, etc.
Defining their organization consists of assigning these activities to the org-units that
will perform them.
We can distinguish between:

e Processes relating to the business of the enterprise: these are difficult to

change unless the enterprise decides to totally review its business.
® Processing depending on organizational choices.

Diversity of variants
Most variants of a process are the result of organizational choices such as giving
preference to urgent orders, special processing for large or export orders, etc.
It is necessary to overcome this diversity in order to move on to a new set of
variants, for example processing orders via telephone or the Internet. Representing
a business process in terms of activities gives a unique representation of the value
chain, highlighting what must be done irrespective of organization choices.

Number of steps
Certain steps in an organizational process are exclusively linked to the chosen
organization. In such cases, it is useful to check whether these steps provide any
real added value to clients or only concern the way things are done.
Delivery times can also be reduced by restructuring the order of these steps.
To highlight possible improvements, you can represent a value streams by flows
exchanged between enterprise value stage.

A value stage is a distinct, identifiable phase or step within a value

stream that has a unique entrance criteria, exit criteria, and identifiable
participating business function or business functional area.
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Value stream example

The following diagram presents an example of a value stream:

Requester 00D  Purchase - Receipt ) Supplier

Purchase Manage { ogistics Aeceane Deflares

O

- ~
~'Purchabe Feques Fecord Purchase

Request
O-------- £ ’
\ Lm
Approve Purchase
Request
e —— 'S
““Purchase Confimed L B0,

““Rejected Purchase Request

" Analyze Required )
Oirder

(—-‘C‘:’

Product &

5 upplier Order

IProduct or Service Deliverg

- " n
Receive Goods or
Services

HED./

ailability

"Purchase reception" value stream

“Profuct or Service Available

.,

The purchase request is recorded and must then be approved.
The requester is informed of the approval or rejection of
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the request. If the request is validated, an analysis of the
required order is carried out.

If stock is lower than a given threshold, an order is
prepared and sent to the supplier for resupply.

If the product is available, or as soon as it is received
from the supplier, it is made available to the requester.

In this example, the business functions concerned are represented in columns.

A business function is a conceptual unit of the division of
responsibilities in an enterprise. It is used to structure the management
of information processing, energy, and equipment produced or used.
Business functions define the skills and the functionalities necessary to

the enterprise to fulfill its mission.
In the organization previously presented, three org-units: purchasing assistant,
purchasing manager and buyer, systematically participate to execute the first four
steps: record and approve the request, analyze and send the order.
Optimization of the organized process "Process Purchase Requests" has saved one
step: when amount of the order is not significant, the purchasing assistant can
himself approve or refuse the purchase request.
In the case of urgent orders, you can again save steps by authorizing the purchasing
assistant to send the order when the amount is not significant.
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We obtain the following value stream for processing of urgent orders:

Requester OO0 Urgent Purchase - Receipt ) Supplier

Purchaze Manage { ogifics Aecaive Dalivaras

Analyze Purchase

=Ilrgent PurchaseRequest | m Request Large amount
¢ Rurchase Confimgd BED
rHejected Purchask Requedt -
Purchasze - Receipt
Stock < Stock mini
Y — -
repare Supplier Order "Supplier Order

““Product or Service Deliverec

N

Receive Goods or
Services

Availability j113)

“Product or Sdrvice Available

F N

"Purchase reception" value stream

The first step consists of analyzing the purchase request.
If the total amount is large, normal processing is carried
out.

Otherwise, the availability request and a restock request
are sent, if necessary. Continuation of this value stream is
identical to the previous one: when the order has been
received, it is made available to the requester.
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SYSTEM PROCESSES

HOPEX Business Process Analysisallows you to model the IT system process implemented when
using an organizational process. This description is made in a BPMN model detailing the sequence
flow of tasks performed when executing the application in the particular context.

The BPMN (Business Process Modeling Notation) specification was created to formalize graphical
representation of IT and business processes, offering notation easily used by all participants
concerned.

The points covered here are:

"Managing a System Process", page 84

"Tasks", page 87

"Sequence Flows, Events and Message Flows", page 88
"Gateways", page 90

"Step Input Gateways", page 90

"Creating a System Process Participant", page 93

ANENENENENEN
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MANAGING A SYSTEM PROCESS

A system process represents automated execution of an organizational process.

The system process diagram uses notation proposed by BPMN standard.

Creating System Processes

You can create a system process from the navigator or from an organizational
process diagram.

A system process is the executable representation of a process. the
events of the workflow, the tasks to be carried out during the
processing, the algorithmic elements used to specify the way in which
the tasks follow each other, the information flows exchanged with the
participants.

To display the view of system processes in an organizational process diagram:
1. Click the ® Views and Details button in the diagram toolbar.
2. Select the Implementation Contexts check box.
3. Click OK.
The Contextualization =%» and System Process [ buttons appear
in the insert toolbar.

To create a system process from an organizational process diagram:

1. Click the System Process button [ in the diagram insert toolbar.

2. Click on the diagram.
The process appears in the diagram.

3. To rename the system process, select it and press your keyboard F2 key.

Connecting a System Process to an Organizational Process

To specify that an organizational process is implemented by a system process in a
given context, you must create a contextualization link between the two objects.

A contextualization allows specification of the implementation of a
process by another process in a specific context, such as the
geographical location on a site.
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For example, the "Process Urgent Purchase Request" process is implemented by the
"Analyze Purchase Request" system process to assure speed and efficiency of
processing.

=T Urgent Purchasing Process

Stant

Supplier Order (Stock < Stock mini)

Process Urgent
Purchase Request » Purchase Request

Rejected Purchase|Request
-« Purchase Confirmed
Completed Purchase Order
Hroduct or Service

Delivered

Make available

Produgt or Service Available

To create a connection between an organizational process and a system process
from an organizational process diagram:

1. Click the @ Views and Details button in the diagram toolbar.
2. Select the Implementation Contexts check box.
3. Click OK.

=

The Contextualization = and System Process [§§ buttons appear in

the insert toolbar.

Click the Contextualization =+ button in the insert toolbar.

5. Click the organizational process and, holding the mouse button down,
drag the cursor to the system process and release the mouse button.
The contextualization appears in the diagram.

P

Creating a System Process Diagram

To create a system process diagram:
) Right-click the process name and select System Process Diagram.
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The system process algorithm can be expressed by sequencing of tasks and

decisions.
Example
The diagram below represents purchase request processing.
e A product search is carried out from the referenced products repository.
e If the product is new, search for a supplier and comparative study of
prices is carried out. An order is then sent and the process ends.
e If the product is referenced, stock is analyzed.
e If stock is sufficient, a "Make available" request is activated and the
process ends.
e If stock is less than minimum stock, an order is sent to the supplier and
the process ends.
Analyze Purchase Request

P _Inventory Management P _Supplier Management ® purchasing Management

Start

Find requested product Find Suppliers
- > o S
Referenced Products Supplier Data
|Requested]
b
Referenced product l
A4
Stock analysis Compare Price and
> Service £on - Supplier, Contracts
Spare Parts Supplier Data H

[in stock] (L L \'1/

Product in stock verification

A 4

Request to make Cancel Request
available  Error
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System Processes

TASKS

Tasks correspond to process steps.

A task is an elementary step that is included within a system
process. A task is used when the work in the system process is not
broken down to a finer level of the process. Generally, an end-user and/
or an IT service are used to perform the task when it is executed.

Creating a task in a system process

To create a task:

1. In the diagram insert toolbar, click the Task 2] button then click in the

diagram.
2. Enter the task name and click OK.
The task appears in the diagram.

Find Suppliers

Tasks :
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SEQUENCE FLOWS, EVENTS AND MESSAGE FLOWS

Sequence flows

Organization of tasks in the system process is represented by sequence flows
between tasks.

A sequence flow is used to show the order in which steps of an

exchange contract will be performed. A sequence flow has only one
source and only one target.

Find Suppliers

.

Compare Price and
Service

Events

Events represent facts occurring during process execution.

[ An event represents a fact or an action occurring in the system,

such as updating client information. It is managed by a broker. An
application indicates that it can produce the event by declaring that it
publishes it. If an application is interested in an event, it declares that it
subscribes to the event.

An example is the start or end of the system process.

O

Start

O

Final

The event can also be sending or receiving a message flow.
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Sequence Flows, Events and Message Flows

Message flows

Message flows represent exchanges between the system process and the exterior.

A message flow represents circulation of information within an
exchange contract. A message flow transports its content.

@.ﬂ. ............................

w A message flow can be linked to an event of message type.

-4 [ Product or Service Delivered C{
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GATEWAYS

In compliance with the BPMN standard, in the object toolbar, several gateway types
are available to you.

Gateways are modeling elements that are used to control how
sequence flows interact as they converge and diverge within a process.

To better understand the main use cases, we distinguish output gateways of a
processing step from input gateways.

Processing Step Output Gateways

In the case of an Exclusive gateway, only one output branch can be selected from
those available. The branch can be selected as a function of the Data available for
the process, or of the Events occurring during its execution.

In the case of a Parallel gateway, all output branches are processed
simultaneously.

[ [
+
d
.r an ) ‘\. or ‘\.
® Y
Parallel Exclusive

In the case of a Complex gateway, one or several output branches can be selected
from those available.

A Complex gateway represents a combination of those above.

When the gateway has been created, its type can be modified in its properties dialog
box.

At output of a step, a gateway represents a point of divergence of sequence flows
of a process.

Step Input Gateways

At input of a step, a gateway represents a point of convergence of sequence flows
of a process.

In the case of an Exclusive gateway, the process step is triggered when one of
these branches is active.
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Gateways :

In the case of a Parallel gateway, all input branches are processed simultaneously.

Parallel Exclusive

Creating gateways

To create a gateway:
1. Click the arrow at the right of the Gateway button in the diagram insert
toolbar and select the gateway type you wish to create.

05 &> Exclusive (Data)
&> Parallel
& Inclusive
& Exclusive (Event)
&> Complex
Parallel (Instantiate)

& Exclusive (Instantiate

2. Click on the diagram.
The gateway appears in the diagram with the shape appropriate to its

type.

Modifying gateways

To modify a gateway:
1. Right-click the gateway and select Properties in its pop-up menu.
The properties windows opens.

2. Click Characteristics.
You can modify the name or type of the gateway.
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Gateway type

The different gateway types proposed are:

Complex: the process can take a complex combination of paths.
Exclusive (Data): the process can take a single path from several
possible paths depending on the value of the data available. This is the
default gateway type.

exclusive (Start): the process is triggered by the first event
occurring. The others are ignored.

Exclusive (Event): the process can take a single path from several
possible paths depending on the events occurring.

Inclusive: the process can take one or several paths simultaneously.
Parallel: the process takes several parallel paths simultaneously.
Parallel (Start): the process is triggered by the first event occurring.
The other events occurring during progress of the process are also
taken into account.

3. Click OK.
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Creating a System Process Participant .

CREATING A SYSTEM PROCESS PARTICIPANT

In a system process diagram, a participant enables grouping of tasks assigned to
an application or service.

To create a participant:
1. In the diagram insert toolbar, click the arrow at the right of the

El Participant button.

B 'fj B Participant

[ B Participant (Application )

B B Participant (IT Service)

@ ~ [ Participant (Application System)

B Participant (Org-Unit)

2. In the list proposed, select for example Application Participant and
click in the diagram.
The participant creation dialog box appears.

3. Click the arrow [»] at the right of the Application field and select

Connect Application.
The query dialog box appears.

4. Find the application and click Connect.

5. In the participant creation dialog box, click OK.
The participant created appears in the diagram with a header containing
the name of the assigned application.

w To place a participant with assignment as yet unknown, select the
Participant icon.

To assign a task to a participant:
} place the task within the frame of the participant.
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SPECIFYING PROCESS BEHAVIOR

Complying with BPMN standard, a process can have different behaviors. With
HOPEX Business Process Analysis, these behaviors are available for
organizational processes, operations, system processes and tasks.

To describe for example that a system process is executed by a loop:
1. Right-click the process and select Properties.
The properties windows opens.
2. Click Characteristics.
3. In the Loop field, select the loop type corresponding to process behavior.
4. Click OK.
Shape of the process is modified to display the symbol of the loop.

Compare supplier
prices

[+]

Behaviors proposed are:

e Transaction: a transaction is a set of coordinated activities leading to a
consistent, and verifiable outcome.

e Loop: aloop is a process step that is repeated as long as a condition is
true.

e "Do while": the condition is evaluated before the first execution.

e "Do until": the condition is evaluated after the first execution. In this
case, the process step is executed at least once.

The predicate enables specification of the loop execution condition.

e Ad hoc: steps of an ad hoc process are not controlled or sequenced in a
particular order. Their performance is determined by the performers of
the process.

e Multiple: the process is repeated a predefined number of times,
evaluated only once before it is carried out. Execution type can be
specified:

e "Parallel": all executions carried out simultaneously.
e "Sequential": executions carried out one after the other.

e Compensation: a compensation defines the set of activities that are
performed during the roll-back of a transaction to compensate for
activities that were performed during the normal flow of the process.

Task type

To specify the type of a task:

1. Open the properties of the process.
2. Click Characteristics.
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3. Click the arrow at the right of the Type Type field.
A list of task types appears.

Call Process: task used to call a second process while executing the
current process.

Receive: elementary task which waits for arrival of a message from a
participant external to the process. When the message has been
received, the task is completed.

Send: task that sends a message to a participant external to the
process. When the message has been sent, the task is completed.
Manual: task executed without the help of a automatic execution
engine of a process or IT application.

Business Rule: execution task of a business rule with a rules engine
which processes input data and returns calculation results.

Script: task executed by a process execution engine. The designer
defines a script in a language that the engine is able to interpret.
When the task is ready to start, the engine executes the script. The
task is completed when script execution is completed.

w  Shape of the process is modified to display the symbol associated
with the task type.

Compensation description

Compensation is caused by an event occurring during process execution. This event
is placed at the edge of the interrupted process. It can be moved along the edge of
the process.

To free the event from the process, use the detach command in its pop-up menu.

This event can trigger a compensation operation.

Request to make Cancel Request
available

w  For reasons of consistency and simplification, the compensation link
is represented in HOPEX by a sequence flow. BPMN standard proposes
a specific link.
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This chapter presents how to describe conversations between process architecture components.

SNENENEN

CONVERSATIONS

LI A conversation describes an exchange of several message flows
between two roles.

A composite conversation is described by an exchange contract.

This exchange contract uses other exchanges or exchange contracts.

"Conversations Example", page 98
"Managing Conversations", page 100
"Managing Exchange Contracts", page 104
"Summary of Concepts", page 109
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CONVERSATIONS EXAMPLE

The Conversation concept is introduced in standard BPMN 2.0.

In HOPEX Business Process Analysis, a conversation is implemented by an
Exchange.
An exchange specifies message flow exchanges between two
participants.
The example of purchase request processing involves several
exchanges between the requester and the "Purchasing
Assistant".

= £ Process Purchase Request “
¥ Purchasing Assistant 1 Purchasing Manager

Stan

i Purchase

Stock Data

Request

i Completed Purchase Order
ziPurchase Confirmed

End
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At the highest level,

the same message flow.

w Purchase Request P
s Purchase Cenfirmed

-4 @ Rejected Purchase Regquel

Bt

|

A conversation is described by a set of message flows with content.

Conversations
Conversations Example

these exchanges can be represented by

An exchange diagram can be built presenting the sequence of message flows

exchanged.

The "Purchase Request" exchange diagram is shown below.

Sender Participant

: Purchase Request

Start

Rejected Purdhase Request

Purchase Confirmed

wedjojued Jaa@oey
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MANAGING CONVERSATIONS

A conversation represents the exchange of information between architecture
components.

LI A conversation describes an exchange of several message flows
between two roles.

Creating Conversations

Creating Conversations with an Existing Exchange

A conversation is described by an exchange representing an information exchange
channel between architecture components.

An exchange specifies message flow exchanges between two
participants.

To create a conversation from an existing exchange:

1. In a process diagram Insertion, click the Conversation | | button.
2. Draw a link between the two entities in communication.
3. In the conversation creation dialog box:

e Specify the name of the conversation.

e Select the Exchange you want to use.

m  You can also create a new exchange, see "Creating Conversations
with a New Exchange", page 100..

4. Click OK.

Creating Conversations with a New Exchange
You can create an Exchange from a library or a process diagram.
To create an exchange from a process diagram:

1. Click the Conversation button || and create a link between the two
communicating entities.
The conversation creation dialog box appears.

2. Click the arrow at the right of the Exchange field and select Create
Exchange.
The Creation of Exchange dialog box appears.

3. Enter the Name of your exchange.

4. Click OK to close this dialog box.
The exchange is automatically created.

5. Click OK.
The conversation appears in the diagram.
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Describing Conversation Message Flows

The message flows exchanged in a conversation are described in the exchange
associated to the conversation.

A message flow represents circulation of information within an
exchange contract. A message flow transports its content.

Exchange is described by message flows and their content which are exchanged
between the two roles representing the stakeholders in the conversation.

The content designates the content of a message or an event,
independent of its structure. This structure is represented by an XML
schema linked to the content. A content may be used by several
messages, since it is not associated with a sender and a destination.
There can be only one content per message or event, but the same
content can be used by several messages or events.

To describe message flows exchanged in a conversation:

1.

Open the Characteristics property page of the Conversation that
interests you.

From Exchange field, you can access to the pop-up menu of the
exchange used.

Open the Message Flow property page of the exchange.

Click the New button.

The Creation of Message Flow - Content dialog box opens.
From the Content drop-down list, select the content you wish to
associate with the message flow.

The message flow with its content is displayed in the list of conversation
contents.

w  You can associate several contents with the message flow.

Specify the direction of each message flow.
Click OK.
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Creating an exchange diagram (BPMN)

The sequence of flows exchanged during a conversation can be described by an
exchange diagram.

i Customer Identification

Service

Start Customer Identification Service

Information about customer

Customer found

Customer Delegate

Customer Information

z
a
o
w
@
=
3
o
5
5
=
3
&
]
o
]
o
o

Error Message

End Customer Identification Service

"Customer Identification Service" Exchange Diagram

The customer identification service protocol begins by
sending information enabling identification of the
customer. An error message appears if the customer is not
found, otherwise customer information is sent (customer
identification, status of orders, etc.).

To create an exchange diagram:

1. Open the Characteristics property pages of the conversation that
interests you.

2. From Exchange field, you can access to the pop-up menu of the
exchange used.

3. In the pop-up menu of the exchange, select New > Exchange
Diagram (BPMN).

The diagram opens. The exchange frame is positioned and the two roles (Consumer
and Supplier) are created. The message flows associated with the exchange are also
positioned in the diagram.
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Creating a composite conversation

A composite conversation is described by an exchange contract. This exchange
contract uses other exchanges or exchange contracts.

An exchange contract is a model of a contract between
organizational entities. This contract is described by exchanges between
an initiator role and one or several contributor roles.

w  For more details on exchange contracts, see "Managing Exchange
Contracts", page 104.

To create a composite conversation from an existing exchange contract:

1.

2,
3.

4,

In the diagram insert toolbar, click the Composite Conversation

button.
Draw a link between the two entities in communication.
In the composite conversation creation dialog box:

e Specify the name of the composite conversation.
e Select the Exchange Contract you want to use.

m  You can also create a new exchange contract.
Click OK.

Replacing a conversation

As standard, a conversation is connected to an exchange. However, from its pop-
up menu, you can replace a conversation with a composite conversation or by the
message flows of the exchange to which it is associated.

To replace a conversation:

1.
2,

Right-click on the conversation to open its pop-up menu.
Select Replace Exchange by an Exchange contract.
A new exchange contract is created and the conversation becomes a

composite conversation.
A composite conversation is described by an exchange contract.
This exchange contract uses other exchanges or exchange contracts.
Select Replace by Message Flows.
The conversation is replaced by the messages flows of its associated
exchange.
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MANAGING EXCHANGE CONTRACTS

An Exchange Contract represents the exchange of information between
architecture components of the process.

An exchange contract is a model of a contract between
organizational entities. This contract is described by exchanges between
an initiator role and one or several contributor roles.
With HOPEX Business Process Analysis, an exchange contract can be built using
exchanges or using exchange contracts.

Exchange Contract Example

Example of exchange contract using exchanges

The "Customer Identification" exchange starts with a
customer search step. If the customer is found, the protocol
returns customer information, if not, a "Customer Creation"
protocol is activated. The result of the "Customer
Identification" exchange contract is a "Customer
Information" message.

{8 Customer Delegate
5 customer idemtification

<Customer Delegate>
Information about customer

Customer Identification Service

<Access to customer data service>
Customer Information

<Customer Delegates ]

Cu creation service

End

B Inf ion about

Exchange contract diagram (BPMN)
Progress steps are represented by Exchange Uses.

An exchange use represents the usage of an exchange in another
exchange contract.
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Example of exchange contract using exchange contracts

With HOPEX Business Process Analysis, a protocol is described by a sequence
flow of steps which are represented:

e by Exchange Uses,

e by Exchange Contract Uses.

An exchange contract use is associated with an exchange contract.
It enables representation of complex exchanges.

The protocol roles, presented at the border of the frame, represent participants
invoker or invoked.

An exchange can be described by involving more than two participants. In this case,
a role is consumer of the exchange contract and the others are providers.

¥ Customer Delegate ]

3 Information requirement

Start

!

Customer Delegate
<Processing operator>

Process Purchase Request

Customer

<Customer Delegate>

| F_’ +]

Access to customer data service

Customer identification

Customer Delegate

<Access to cusiomer data service>

«<Process Purchase Service>

Customer Delegate
<Opérateur de traitement (FR) » OMgEr Request

<Customer>

End

Purchase Request Analysis ' 4]

<Customer Delegate>

Process General Requests

Request Type Access to customer data service
<Process Purchase Service>

"Information Requirement" Exchange Contract Diagram (BPMN)

The "Information Request" exchange contract is used by the
supplier call center to take account of a customer request
online. There are therefore three participants in this
contract: the customer, the IT applications and the
customer representative who is the effective requester of
the service (in this case the call center).

This contract consists of identifying the customer, then
analyzing the request. The request is then processed as a
purchase request or as another request if it is an
information request for example.
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Using Exchange Contracts

An Exchange Contract is described by a Composite Conversation which
represents the information exchange channel between architecture components.

An exchange contract is a model of a contract between
organizational entities. This contract is described by exchanges between
an initiator role and one or several contributor roles.

A composite conversation is described by an exchange contract.
This exchange contract uses other exchanges or exchange contracts.

To create a composite conversation:

1.

N

In the diagram insert toolbar, click the Composite Conversation |}
button.

Draw a link between the two entities in communication.

In the add composite conversation dialog box, specify the name of the
conversation and the exchange contract you want to use.

w  You can also create a new exchange contract, see "Creating
Conversations with a New Exchange"”, page 100..

Click OK.

Creating Exchange Contracts

To create an exchange contract from a composite conversation:

To create an exchange contract from a composite conversation:

1.

ok

In the diagram insert toolbar, click the Composite Conversation |}
button.

Draw a link between the two communication entities.

In the composite conversation creation dialog box, click the arrow on the
right of the Exchange Contract field and select Create Exchange
Contract.

The Creation of Exchange Contract dialog box opens.

Enter the name of the contract in the Name box.

Click OK.

The composite conversation and exchange contract are created.
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Describing Exchange Contracts

An Exchange Contract can be supported by Exchanges or Exchange Contracts
representing information exchanges between architecture components.

An exchange contract is a model of a contract between
organizational entities. This contract is described by exchanges between
an initiator role and one or several contributor roles.

An exchange use represents the usage of an exchange in another
exchange contract.

An exchange contract use is associated with an exchange contract.
It enables representation of complex exchanges.

To describe that an exchange is used by an exchange contract:

1. Open the exchange contract properties dialog box.

2. Select the Exchange tab.

3. Click the New button.
A selection dialog box opens.

4. Select Exchange Use, which is the type of exchange you want to use,
and click OK.
The creation dialog box opens.

5. Click the arrow at the right of the Specification box.

6. Select List in the drop-down list and select the exchange to be
associated with the exchange use.
The name of the exchange appears in the Specification field.

7. In the From field, select the described exchange role connected to the
Invoker role of the exchange used.

8. In the To field, select the described exchange role connected to the
Invoked role of the exchange used.

9. Click OK.

m  You can associate several exchanges with the exchange contract.
10. Click OK.

Creating an Exchange Contract Diagram

With HOPEX Business Process Analysis, an exchange contract is represented by
an Exchange Contract Diagram (BPMN).

To create an exchange diagram:

1.
2,

Right-click the conversation containing the exchange.
In the pop-up menu of the exchange, select New > Exchange
Contract Diagram (BPMN).

The diagram opens with the exchange contract frame and the two roles representing
invoker or invoked.
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Defining exchange and exchange contract uses

In an Exchange Contract Diagram (BPMN), operations are described by:

e Exchange Uses
e Exchange Contract Uses

An exchange use represents the usage of an exchange in another
exchange contract.

An exchange contract use is associated with an exchange contract.
It enables representation of complex exchanges.

To create an exchange contract use:

1. Click the Exchange Contract Use button =: and click in the diagram

within the exchange contract frame.
The creation dialog box opens.

2. Click the arrow at the right of the Specification box.

3. Select List in the drop-down list and select the exchange contract
associated with the exchange contract use.

4. In the From field, select the described exchange role connected to the
Invoker role of the exchange used.

5. In the To field, select the described exchange role connected to the
Invoked role of the exchange used.

6. Click Finish.

HOPEX Business Process Analysis



Conversations

Summary of Concepts

SUMMARY OF CONCEPTS

Exchange

Exchange contract

Definition

An exchange specifies message flow
exchanges between two participants.

An exchange contract is a model of a
contract between organizational entities.
This contract is described by exchanges
between an initiator role and one or sev-
eral contributor roles.

Use in a Process

)| A conversation describes an

(= A composite conversation is

Diagram .
exchange of several message flows described by an exchange contract. This
between two roles. exchange contract uses other exchanges
or exchange contracts.
Use in an

Exchange Con-
tract Diagram

=% An exchange use represents the

usage of an exchange in another
exchange contract.

= An exchange contract use is associ-
ated with an exchange contract. It
enables representation of complex
exchanges.
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ORGANIZATIONAL CHARTS AND
RESPONSIBILITIES

HOPEX enables representation of enterprise structure It indicates the hierarchy of org-units in the
enterprise, specifies the persons that play the role of these org-units, and shows at which site the
org-unit is located.

HOPEX also enables definition of organizational process responsibilities by means of the RACI
matrix (Responsible, Accountable, Consulted, Informed) as well as business processes.

v/ "Managing a organizational chart", page 112
v "Process responsibilities", page 116
v "Organizational process and operation responsibilities (RACI)", page 118
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MANAGING A ORGANIZATIONAL CHART

An organizational chart provides an overview of the enterprise structure. HOPEX
Business Process Analysis allows you to design your organizational charts using
the same tools and methods as applied to processes.

HOPEX Business Process Analysis organizational charts contain the following
descriptive objects:
e Org-Units, which are generally elements defining the enterprise
structure, such as Sales Department.

e Sites that are geographical locations pivotal to the organization, such as
headquarters, plants, etc.

Organizational chart example

~&  HBC Group

T 1 [ T ]

T General | —= Logistics —= Marketing ~= Administration & 44 Sales S Operation
Management | Management Management Finances Management M anagement
M t %
3 - Sales
~a Transportation s Stock B Department
Service Management
. I v Sales Dffice
o Stock M -~ ini £
im oc anager . !:‘lmﬁhe:i AT
Storage

Creating an Organizational Chart

To create an Organizational Chart from the Process Design navigation pane:

1. Select Organization > Org-Units and All Org-Units tab.
The list of existing actors appears.

2. Right click on an org-unit and select New > Org-Unit Organizational
Chart.

The corresponding organizational chart opens. It is automatically
initialized with the component org-units of the described org-unit.
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Organizational Charts and Responsibilities .
Managing a organizational chart :

Drawing an Organizational Chart

Searching for Objects

To simultaneously add all the org-units involved in your processes that were not
automatically inserted at diagram initialization:

1. In the query tool, select the Org-Unit object and click the Find button

Bl

o HOPEX & (2 -
57D BUSINESS PROCESS ANALYSIS ® | & org-Unit > &

The result dialog box appears.
2. Select the desired org-units holding the <Shift> key down.

© when you click on an object while holding down the Ctrl key, you

add it to the list of selected objects if it was not previously selected, or
you remove it from the selection if it was.

3. Drag-and-drop the selected objects from the result dialog box into the
diagram.

© when an org-unit appears in a diagram, you can describe it with a
new organizational chart using its pop-up menu.

4. Draw the links between these org-units.
m  Note that certain links might already exist.

When you create a link between two org-units, always drag from the org-unit higher
in the hierarchy down to the subordinate. Once the link is drawn, an arrowhead
indicates the direction of the hierarchy.

Specifying org-unit properties

To specify the properties of an org-unit:

1. Open the Characteristics property page of the Org-Unit.
2. In the Org-Unit-Type list box, select the org-unit type.

There are several types of org-units:

e “Vendor"

e “Institution”

e “Company”

e "“Public Department”

e "Structure" (for example, Sales Management).

e “Function” (for example, Sales Engineer)

e “Accountable” (for example, Sales Manager)

e “Generic”: corresponds to a role to be played during a project (Writer,

Requester,...).

m  You can also specify its details (company name, e-mail address,
telephone number, etc.).
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Associating a person with an actor

You can connect Person (System) with an Org-Unit.

w A person (System) represents a person in the enterprise. This
person can be assigned a login and a role (or a profile depending on the
connection mode). The login provides access to the HOPEX Application.
The role (or the profile) defines the access to product functions and
repositories. A system person, if assigned a login, has a specific desktop
in each database, and can connect to this desktop from any workstation
in a given environment.

'm Account Manager

Alan Harvis
Jdacoies Dupond
MNancy Timazl

The name of the persons linked to the org-unit appear in the org-unit frame.

To associate a Person (System) with an Org-Unit:

1. Expand the Responsibility section of the Characteristics property
page of the Org-Unit.
w  To display the Responsibility section, open the Options window

and check that Business Process and Architecture Modeling >
System Person Management is activated.

2. (Option) In the Owner field, select the Person (System) which is the
owner of the entity represented by the org-unit.

3. (Option) In the Org-Unit member tab, select the concerned Person
(System).

Associating a site with an org-unit

You can also add sites = | where the org-units are located.

A site is a geographical location of an enterprise. Examples: Boston
subsidiary, Seattle plant, and more generally the headquarters,
subsidiaries, plants, warehouses, etc.

Consulting reports associated with org-units

HOPEX Business Process Analysis provides several reports about org-units.

To view these reports:

) Open the Report property page of the Org-Unit.
The list of available reports is proposed.

Consulting the Org-Unit Structure report

HOPEX Business Process Analysis proposes a report in the form of a matrix
which presents:

e The selected org-unit, its type and the associated persons
e The selected org-unit, its parent Org-Unit and the associated persons
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Organizational Charts and Responsibilities .
Managing a organizational chart :

To consult the Org-Unit Structure report
} Open the Report > Structure property page of the Org-Unit.

Consulting the Org-Unit Job Description report

HOPEX Business Process Analysis proposes a report which presents:
e The selected org-unit type

e the organizational processes and operations in which these org-units
intervene.

w  RACI is the acronym of Responsible, Accountable, Consulted,
Informed.

Consulting the RACI Matrix of Org-Units

w  For more details on the use of RACI, see "Generating a RACI matrix
from a organizational process", page 116.

HOPEX Business Process Analysis proposes a report in the form of a matrix
which presents:

e the selected org-unit and sub-org-units

e the organizational processes and operations in which these org-units
intervene.

m  RACI is the acronym of Responsible, Accountable, Consulted,
Informed.

To consult the RACI matrix:
) Open the Report > RACI property page of the Org-Unit.
To generate the matrix to search for org-units in depth, you must use report "Org-

Unit and Sub-Org-Unit RACI Matrix (BPMN)". For more details, see "Launching an
RACI matrix from an object", page 123 (operation identical to business processes).
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PROCESS RESPONSIBILITIES

From an organizational process or a business process, you can:

e define process control responsibilities
e view org-units concerned by the organizational processes connected to

this process
w  RACI is the acronym of Responsible, Accountable, Consulted,
Informed.

Defining process control responsibilities

Business processes are managed by persons. The business process steering team
therefore comprises a list of persons whose individual roles in the team can be

indicated.
To specify organizational process control responsibilities:
1. Open the organizational processes Characteristics property page and

expand the section Responsibility.
2. Select one of the following tabs to create or connect the persons

(system) involved in process control:
e “Organizational process Designer”
e “Organizational Process Contributor”
3. Select Organizational Process Owner .

Generating a RACI matrix from a organizational process

From an organizational process you can generate a matrix presenting:
e organizational processes connected to current process or to its sub-

processes
e operations of these organizational sub-processes
e org-units concerned by these organizational processes and operations

To generate an RACI matrix from a organizational process:
1. Right-click the business process and select Report Discovery.
2. In the list of available reports, click Process Analysis.
3. From the "Business Process RACI Matrix (BPMN)" report, click Launch a

new report.
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Process responsibilities

In the generated report, select report chapter "Business Process RACI
Matrix (BPMN)".
You obtain a result like this:
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w
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| ©
@ Deliver Vacation Business
& Invoice Customer (A)
& vacation Package Booking | (a)
& vacation Package Delivery (a)
& vacation Request Formalization (a)

w To generate a matrix to search for organizational processes and

operations in depth, you must use report "Business Process and Sub-
Process RACI Matrix (BPMN)".
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ORGANIZATIONAL PROCESS AND OPERATION
RESPONSIBILITIES (RACI)

HOPEX Business Process Analysis specifies the responsibility level of the various
org-units:

e on an operation

e on an organizational process. The proposed responsibility levels are as

follows:
Responsibility Meaning
Responsible Org-unit responsible for the operation or process
Responsible Org-unit monitoring progress of the operation or process and

taking decisions.
There is only one "Accountable" org-unit for each action.

Responsible/Accountable Org-unit executing the operation or process, informs on
progress and takes decisions.
There is only one "Accountable" org-unit for each action.

Consulted Org-unit consulted as first priority before an action or deci-
sion.
Informed Must be informed after an action or decision.

w  RACI is the acronym of Responsible, Accountable, Consulted,
Informed.

Prerequisites to using RACI
One option is used to display the information about RACI.

To activate this option:

1. In the workspace, open the Options window.

2. In the left tree, select Business Process and Architecture Modeling:

3. Select the Managing RACI (BPMN) / Automatic synchronization of
RACI by means of participants check boxes.
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Organizational process and operation responsibilities (RACI) .

Defining responsibilities

Organizational Processes Responsibilities

To indicate the responsibility of an org-unit in an organizational process:
1. In the organizational process Characteristics property page, expand
the Responsibility section.
2. Select one of the following tabs to create or connect the persons
(system) involved in process control:
e “Organizational process Designer”
e “Organizational Process Contributor”
Then select Organizational Process Owner.
In the Org Unit section, click the Connect button.
In the dialog box that opens, select Candidate Org-Units (RACI) and

ke

click the Find button @
A dialog box proposes the list of org-units that execute the operation or
the process via a participant.

w  An org-unit can be connected directly to an operation or process or

indirectly via a participant. An RACI candidate org-unit is an org-unit
assigned to a participant.

6. Select the org-units that interest you and click Relier.
The org-units appear in the properties dialog box of the operation or
process.

7. For each of these, in the RACI drop-down list, select a responsibility
level from the four proposed.
e Consulted (C)

Responsible (R)

Responsible/Accountable (R/A)

Informed (I)

Accountable (A)

Operations responsibilities

To indicate the responsibility of an org-unit in an operation:
1. In the operation Characteristics property page, expand the Actors
section.
2. Click the Connect button.
3. In the dialog box that opens, select Candidate Org-Units (RACI) and

click the Find button @
A dialog box proposes the list of org-units that execute the operation or
the process via a participant.

m  An org-unit can be connected directly to an operation or process or

indirectly via a participant. An RACI candidate org-unit is an org-unit
assigned to a participant.

4. Select the org-units that interest you and click Relier.
The org-units appear in the properties dialog box of the operation or
process.

119



120

5. For each of these, in the RACI drop-down list, select a responsibility
level from the four proposed.

Consulted (C)

Responsible (R)
Responsible/Accountable (R/A)
Informed (I)

Accountable (A)

The selected responsibility level appears with an icon corresponding to context:

Icon

Meaning

Indicates that responsibility is deduced from the participant.
The icon appears when the selected org-unit is:

- assigned to the participant, and

- declared with Responsible responsibility (default responsibil-
ity).

No icon

There is no icon when the selected org-unit is:

- assigned to the participant, and

- declared with responsibility other than Responsible (default
responsibility).

A

The icon appears when the selected org-unit is not assigned to
the participant.

Org-units displayed in a participant

The list of org-units displayed in the header of the shape of a participant groups:

org-units attached to the participant but with no responsibility in the
process or operations executed by the participant. These org-units are
declared in the properties of the participant.
w  For more details on org-units connected to a participant, see
"Assigning an org-unit to a participant”, page 43.
org-units attached to the participant but with a responsibility in the
process or operations executed by the participant. The name of the
org-units is followed by a letter corresponding to their responsibility.
These org-units are declared in the properties of the participant.
w  For more details, see "Responsibilities of org-units of a participant”,
page 121.
org-units not attached to the participant but with a responsibility in
the process or operations executed by the participant. These org-units
are declared in the properties of at least one process or operation
executed by the.

w  For more details, see "Organizational Processes Responsibilities",
page 119.
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Organizational process and operation responsibilities (RACI) .

Responsibilities of org-units of a participant

To indicate responsibility of each of the org-units attached to a participant in the
different operations or organizational processes it executes:
1. Open the RACI property page of the participant.
The analysis report is displayed carrying the letter representing the
responsibility of the org-unit in the process or operation:
(A) for Accountable
(R) for Responsible
(R/A) for Responsible/Accountable
(C) for Consulted
(I) for Informed

1. RACI Management Matrix

& process Purchase Request

E B Purchasing Department g0

& process Purchase Order

In the example above, the "Purchasing Department" assigned
to the participant to which the analysis relates, executes
the "Process Purchase Request" process and is Accountable
for "Process Purchase Order".

121



122

2. Click
The context of responsibility of the org-unit is indicated. You can view:

e the name of the participant to which the org-unit is assigned
e the name of the process that is owner of the participant

&
o
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o
=
=
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m
o
[
o
o
=
i
™
e
O
o
=
[
3 process Purchase Request A
""" M Purchasing Departrnent = Standard Purchase Process

To define the responsibility level of an org-unit related to an operation or
organizational process:

1. Open the RACI property page of the participant.

2. Click on the corresponding cell in the matrix.

= Approve Request

- Approve Request

. . . Purchasing Manager s
3|

T Analyze Purchase Request

A selection dialog box opens.

Click the arrow at the right to display the list of responsibility levels.
Select the level that interests you.
Click OK in the selection dialog box.

Click button %) on the right to refresh the report.

o ako
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Using RACI Matrices

HOPEX Business Process Analysis allows you to generate reports in the form of
matrices which identify and analyze data of your repository so as to have a clearer
view of the information.

w  For more details on the use of analysis reports, see the HOPEX
Common Features guide.

Launching an RACI matrix from an object

When you launch an RACI matrix form an organizational process, the list of sub-
processes is automatically deduced from the links between org-units and
organizational processes/operations.

The following are reports available from an organizational process:

e Organizational Process RACI Matrix (BPMN)
This matrix queries organizational sub-processes and operations located
under the organizational process.

e Organizational Process and sub-processes RACI Matrix (BPMN)
This matrix drops n levels to retrieve sub-processes and operations
located under the organizational process.

w  The principle is the same with org-units and business processes.

w To generate a matrix to search for organizational processes and
operations in depth, you must use report "Business Process and Sub-
Process RACI Matrix (BPMN)", page 192.

To access this type of matrix:

1. Right-click the process and select Report Discovery.

2. ClickProcess Analysis and select an RACI report that references sub-
objects.

3. Open the report properties page via the Customize and Launch New
Report button.
The report properties page opens and the report is accessed in the
Reports tab.

w  Click button ¥ on the right to refresh the report if you have
modified objects or parameters of the report.

Creating an RACI with objects of your choice

The "RACI Management (BPMN) report allows you to create a matrix which displays:

e org-units in columns
e operations or organizational processes in rows

w  Cells present RACI values: R for Responsible, A for Accountable, C
for Consulted, I for Informed.

w  For more details, see "Managing RACI (BPMN)", page 188.
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THE CUSTOMER JOURNEY

The HOPEX Customer Journey module is used to represent the acquisition process of a product
or a service by a specific customer. Mapping a customer journey provides an overview of customer
expectations, painpoints encountered, and the resources used at each step of the journey. Last but
not least, touchpoints, which are the points of interaction between the customer and the company,
are used to measure and improve overall customer satisfaction.

As customer journey mapping is created with HOPEX Customer Journey in tabular input mode
only, the HOPEX Customer Journey module is therefore only available with the HOPEX Web
Front-End module.

Representing a customer journey will allow you to easily identify these critical points. HOPEX
Customer Journey is used to describe solutions for improvement and to assess them at different
dates.

The points covered here are:

"Presentation of the HOPEX Customer Journey Module", page 126
"Managing the Components of a Customer Journey", page 132
"Assessment of a customer journey", page 145

"The reports available on a customer journey", page 152

SNENENEN
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PRESENTATION OF THE HOPEX CUSTOMER JOURNEY

MODULE

Associated with HOPEX Business Process Analysis, the HOPEX Customer
Journey module supports the methodology and the tools that are used to describe
and improve the acquisition process of your products and services.

The methodology embedded in the HOPEX Customer Journey module is based
on the features of the HOPEX Suite to describe and manage the different project
phases and steps in the customer journey.

Last but not least, the HOPEX suite assessment tool is used to record, over time,
an assessment of the steps in the customer journey. The consolidated results of
these assessments are visible in the customer journey diagrams. Standard reports
are also available to facilitate analysis of the journey and help with identifying a
solution for improvement.

This presentation is based on the example of a travel agency
that offers different types of holidays to different types
of customers.

The HOPEX Customer Journey module is introduced here by :

e "Description of a Customer Journey", page 126
e "Assessing a customer journey", page 131

Description of a Customer Journey

To be able to benefit, at the end of your customer journey representative work, from
the analysis facilities offered by HOPEX Customer Journey, we recommend you
follow the methodological steps shown in the diagram below.

Create, Place
Create, . Define .
Create, manage manage touchpeints
personas in repository m::nn;geo::‘l’c:ses channels in evcﬂre?r:" inside customer
P ¥ repository Journey map
Rate customer
Identify satisfaction and
Moments of other criteria for Make reports P(OPOSI::;CﬁDI'I
Truth each B
touchpoint

Describe activities in
touchpeints and link
Business Processes,
actors, arfifacts

- Mandatory

- Optional

HOPEX Business Process Analysis



The customer journey
Presentation of the HOPEX Customer Journey Module

Defining persona and business lines

This consists of preparatory work identifying the different types of customers
according to their needs and what they bring to the company.

The purpose of this phase is to identify the persona as well as the business lines.

A persona corresponds to a customer segment targeted by the
experience of the client journey. The resources implemented to give
customers the ability to interact with the enterprise and its
environment, to acquire the expected results, are supported by the
interaction channels.

A business line is a high level classification of main enterprise

activities. It corresponds for example to major product segments or to
distribution channels. It enables classification of enterprise processes,
organizational units or applications that serve a specific product and/or
specific market.

Using our example of the travel agency, we are interested in
the young adult segment. The business line preferred for
this population is "Sports holidays".
You must begin by assessing the customer expectations for each persona.
A customer expectation is an enterprise result expected by the
persona at the end of the journey.
For example, a population of young adults can expect, with a
sports holiday, a wide range of activities in an exceptional
setting for a reasonable price.

From a methodological point of view, we suggest you proceed as follows:
1. Identify the customer segments,
2. Define, via the hierarchy, the persona groups and the persona
associated with each segment,

w  For more details, see "Defining persona hierarchy", page 132. and
"Creating a persona", page 132.

3. Identify the org-units that correspond to the segments,

w  For more details, see "Entering the org-units associated with a
persona”, page 133.

4. Create customer expectations for a given persona,

w  For more details, see "Specifying the expectations of a persona”,
page 133.

5. Create the business lines.
w  For more details, see "Creating a business line", page 134.
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Defining the customer journey

Each customer journey corresponds to a specific persona . So, when the persona
are identified, you can create customer journeys.
w If you wish, you can also create the customer journey first and the
persona second.
A customer journey is used to describe and organize all interactions
between the enterprise and a persona for a given result.
We can, for example, build the customer journey that
corresponds to a "sports holiday" for a "young adult"

persona.
w  For more details, see "Creating a customer journey", page 134.

Defining the phases of a customer journey

A customer journey is described by a number of sequenced phases.
A customer journey phase is a time or experience-bound period
within a Customer Journey.
In the example "sports holiday", we identify three phases:
the "selection of holidays", the "qualification of
holidays" selected and the holiday "reservation".
w  For more details, see "Defining the customer journey phases in
tabular input mode", page 136.

Defining the steps in a customer journey

The customer journey steps are closely linked to the business line. The customer
journey steps are organized to most closely represent reality. They are essential
because the assessments deal with each of the steps of a customer journey.
A customer journey step is the basic elementary advancement unit
of a customer via a customer journey phase.
In the "reservation" phase of the holiday, we can identify
the following steps: "Validate the order", "Complete the
customer information", "Proceed with payment".

Finally, the resources used at each step of the customer journey are represented by

channels .
A channel is used to identify the enterprise resources used by a
persona to achieve a step. For example, a channel can be a phone or
internet connexion.
In our example for selling sports holidays,
made available to customers are advertising brochures,
applications and a support service to answer customer

the resources
web

questions.

To describe the steps of a customer journey, we suggest you proceed as follows:
1. Define the customer journey steps associated with each phase.
w  For more details, see "Creating the customer journey steps in
tabular input mode", page 137.
2. Describe the sequences that link the steps.
w  For more details, see "Organizing the customer journey steps in
tabular input mode", page 138.
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Presentation of the HOPEX Customer Journey Module

3. Link the steps to the channels concerned.

w For more details, see "Defining the channels in a customer
journey", page 139.

At this stage, the diagram that you are building with HOPEX Business Process
Analysis looks like the figure below.

4o Sports holidays - Young
adult i
Search holidays

& Youngadult

@ Sports holidays

Understanding customer expectations and painpoints

Each customer journey step can be linked to:
e one or more customer expectations.
An external org-unit is an external entity that exchanges flows with
the enterprise. Example: customer, supplier, government office.
The expectations of young adults for a sports holiday can
concern the context of the holiday or activities offered.

w  For more details, see "Adding persona expectations to customer
journey mapping", page 140.

® one or more painpoints.
A painpoint describes the difficulties encountered by a persona
when carrying out a step in the customer journey.

The painpoints of a group of young adults can concern the
painpoint of agreeing, prices that are too high or the
possibilities of accessing the vacation site.

w  For more details, see "Defining customer painpoints”, page 141.

Identifying the touchpoints

The objective is to identify the organizational elements that are used during the
customer journey and that could have an impact on customer satisfaction.
A touchpoint describes an interaction between a persona and an
enterprise.
The touchpoints between the customers and the travel agency
are by telephone and by email. A support center can thus be
put in place.

w  For more details, see "Creating a touchpoint in a customer
journey", page 142.

129



Each touchpoint can be linked to:
one or more business opportunities.

An opportunity characterizes an improvement action for one of the
composite elements of the customer journey (steps, touchpoint).

To be able to offer another holiday if the holiday selected
is no longer available constitutes a business opportunity.

w  For more details, see "Defining the business opportunities of a
customer journey", page 142.

® one or more painpoints.

Identifying moments of truth
A moment of truth is a decisive step for the remainder of the

customer journey. Either customers believe that they cannot obtain
what they are searching for under the desired conditions and they are
not satisfied; Or, on the contrary, they believe that they have found

what they are looking for and continue the journey.
A reservation that is too late constitutes a moment of
truth. The sports holiday is completed or, on the contrary,

it was canceled due to low staff numbers.
w  For more details, see "Identifying a moment of truth", page 143.

Following this last description step of your customer journey, you obtain a diagram

that looks like this.

HOPEX Business Process Analysis
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Assessing a customer journey

Customer satisfaction can be assessed at each step of the customer journey on a
list of criteria by a number of people on different dates.
A customer journey step is the basic elementary advancement unit
of a customer via a customer journey phase.

w  For more details, see "Assessment of a customer journey", page
145.

The assessment criteria are presented in a questionnaire specific to each customer
journey.
The results of the assessments filled in for the steps of a customer journey are then
consolidated and accessible from:

e reports available on a customer journey,

w For more details, see "The reports available on a customer
journey", page 152.
e the shape of the steps in the diagram of the customer journey which is
different depending on the results of the assessment,
e the Assessment > All Assessed Customer Journeys folder,
e the properties page of the customer journey in the Assessment tab.
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MANAGING THE COMPONENTS OF A CUSTOMER JOURNEY

The following points are covered here:
e "Describing persona and persona groups", page 132,
"Using Business Lines", page 134,
"Building a customer journey", page 134,
"Describing the steps of a customer journey", page 137,
"Client expectations and painpoints", page 140,
"The touchpoints and the business opportunities of a customer journey",
page 141,
e "Creating Action Plans", page 143.

Describing persona and persona groups

This phase consists of identifying the different customer segments according to their
needs and what they bring to the company.

A persona corresponds to a customer segment targeted by the
experience of the client journey. The resources implemented to give
customers the ability to interact with the enterprise and its
environment, to acquire the expected results, are supported by the
interaction channels.

Defining persona hierarchy

A persona group is grouping of personas according to similar
objectives on several customer journeys.
To create a persona:
1. Open the Customer journey navigation window.
2. Select Customers > Persona Groups.
The Persona Group tree appears in the edit area.
3. Click on the tree root to display its pop-up menu and select New >
Persona Group.
The Creation of a Persona Group window appears.
4. Enter the name of the group.
"Sports clientele" and "Young clientele", for example.
5. Click OK to close this dialog box.
The persona group that you have just created appears in the tree of the
Persona Group.

Creating a persona

A persona corresponds to a customer segment targeted by the
experience of the client journey. The resources implemented to give
customers the ability to interact with the enterprise and its
environment, to acquire the expected results, are supported by the
interaction channels.

You can create a persona from a persona group or from of the persona tree.
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You can create a report from the persona tree.

1.
2,

Open the Customer journey navigation window.

Select Customers > Persona.

The Persona tree appears in the Edit Area.

Right-click the tree root to open its pop-up menu and select New >
Persona.

The Creation of a Persona page appears.

Enter the name of the persona.
"Young adults", for example. This persona can be connected

to two persona groups: "Sports clientele" and "Young
clientele".

Click OK to close this dialog box.
The persona you have just created now appears in the persona tree.

Specifying the expectations of a persona

An external org-unit is an external entity that exchanges flows with
the enterprise. Example: customer, supplier, government office.

To create a customer expectation from a persona:

1.
2,

3.

4,
5.

Open the properties window of the persona that interests you.

In the Customer Journey tab, expand the Customer Expectations
section.

Click New.

The Creation of a Client Expectation window appears.

Enter the name of the customer expectation.

Click OK.

The customer expectation is added to the list of persona expectations.

Entering the org-units associated with a persona

A persona can be associated with Org-Units explicitly described in your repository.

An org-unit represents a person or a group of persons that
intervenes in the enterprise business processes or information system.
An org-unit can be internal or external to the enterprise. An internal
org-unit is an organizational element of enterprise structure such as a
management, department, or job function. It is defined at a level
depending on the degree of detail to be provided on the organization
(see org-unit type). Example: financial management, sales
management, marketing department, account manager. An external
org-unit is an external entity that exchanges flows with the enterprise.
Example: customer, supplier, government office.

To define that an org-unit embodies a persona:

1.
2,

3.

Open the properties window of the persona that interests you.

In the Customer Journey tab, expand the Persona Realization
section.

Click the New button.

The window for business agent realization opens.

Select the org-unit that is associated with the persona and click OK.

The business agent realization appears in the properties page of the
persona.
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Creating a business line

A business line is a high level classification of main enterprise
activities. It corresponds for example to major product segments or to
distribution channels. It enables classification of enterprise processes,
organizational units or applications that serve a specific product and/or
specific market.

To create a business line:

1. Open the Customer journey navigation window.

2. Select Customers > Business Lines.

The business line tree appears in the edit area.

3. Click on the tree root to display its pop-up menu and select New >
Business Line.
The Creation of a Business Line window appears.
Enter the Name.

Click OK to close this dialog box.
The business line appears in the business line tree.

ok

Connecting a business line to a customer journey

Customer journeys connected to a business line are accessible from the
Characteristics tab of the business line.

w  For more details, see "Connecting a customer journey to a business
line", page 135.

Building a customer journey

A customer journey is used to describe and organize all interactions
between the enterprise and a persona for a given result.
A customer journey is associated with a persona. Therefore, a customer journey can
be created in three different ways:
e from a persona or a persona group,
e from a customer journey group,
e directly from the Customer Journey navigation pane.

Creating a customer journey

To create a customer journey directly:
1. Open the Customer Journey navigation pane.
2. Select Customer Journeys > All Customer Journeys.
A list of customer journeys is displayed in the edit area.
3. Click on the tree root to display its pop-up menu and select New >
Customer Journey.
The Creation of a Customer Journey window appears.

4. Enter the Name.
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5. Click OK to close this dialog box.
The customer journey appears in the customer journey tree.

Connecting a customer journey to a persona

To connect a persona to a new customer journey from the customer journey tree:

1. Select the line of the new customer journey.
2. Click in the Persona column.
3. Select the persona that interests you.

w The persona associated with a customer journey is accessible in the
Characteristics tab of the customer journey.

Connecting a customer journey to a business line

To connect a business line to a customer journey

1. Open the properties window of the customer journey in question.
2. Select the Characteristics tab and expand the Business Lines
section.
3. Click Connect.
Select the business line that interests you.

w The customer journey is accessible in the Characteristics tab of
the business line.

Creating a customer journey group

A customer journey group consolidates the journeys that comply
with similar criteria.

To create a customer journey group

1. Open the Customer journey navigation window.
2. Select Customer Journey > All Customer Journey groups.
A list of customer journey groups is displayed in the edit area.

3. Click on the tree root to display its pop-up menu and select New >
Customer Journey group.
The Creation of a Customer Journey Group window appears.

4. Enter the name of the group.

"Sports holidays" and "cruises"?, for example.
5. Click OK to close this dialog box.
The Customer Journey group that you have just created appears in the
tree of the Customer Journey Group.

Using the Characteristics tab of the customer journey properties window, you can
then connect the customer journey to the group.

Creating a customer journey mapping

Customer journey mapping can only be created and updated in tabular input mode.
~
w  Tabular input is available with the HOPEX Web Front-End

module. For more information on using tabular input, see the "Entering
a diagram in tabular mode" in the HOPEX Common Features guide.
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To create a customer journey mapping:
1. In the navigation pane, right-click on the customer journey concerned to
display its pop-up menu.

w [f a mapping already exists for the selected customer journey, its
name appears in the pop-up menu of the object.
2. Select New > Customer Journey Map.
The UI of the table input mode opens in the edit area. The tabs available
are Phases and Steps.

Defining the customer journey phases in tabular input mode

A customer journey phase is a time or experience-bound period
within a Customer Journey.

A customer journey is described by several sequenced phases.

w  The list of phases of a customer journey is accessed from the
Characteristics properties window, in the Phases section.

& Sports holidays - Young
adul

S Young adult

@ Spons holidays

Diagram of a customer journey connected to a persona and a business line with phases

Creating a customer journey phase in tabular input mode

To create a phase in tabular input mode for a customer journey:

1. Click the Phase tab.

2. Click New.
The new phase appears in the list of journey phases.

3. Click on the name of the phase to update it.
If you are in Auto Refresh mode, the diagram is automatically updated,
otherwise click Refresh Diagram to display the new phase in the
diagram.

Ordering the customer journey phases in tabular input mode
By default, the phases are ordered in the order of creation.

To modify the order of a customer journey using its diagram:
1. Click the Phase tab to access the list of diagram phases.
2. Select the phase whose order you want to modify and click in the Order
column.
3. Modify the value of the order of the phase.

w [f you enter an order number that already exists, the order of
creation remains the same in the diagram.
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Create several customer journey phases simultaneously

To simultaneously create several ordered phase for a customer journey:

1. Click the Multiple Creation button.
A creation window appears.

Create ®
Concept: Phases

Number of phases: 2

Number of steps: 1

Linear phases Phase with s...

N

Enter the Number of phases you wish to create.
3. If you wish to create phases with steps, specify the Number of Steps
that you wish to create for each phase.

w The steps created in the same phase are sequenced.

4. Click OK.

Describing the steps of a customer journey

A customer journey step is the basic elementary advancement unit
of a customer via a customer journey phase.

A customer journey is described by several sequenced steps.

w  The list of steps of a customer journey is accessed from the
Characteristics properties window, in the Phases section.

You can, for example, proceed as follows:

1. "Creating the customer journey steps in tabular input mode", page 137,

2. "Organizing the customer journey steps in tabular input mode", page
138,

3. "Defining the channels in a customer journey", page 139.

Creating the customer journey steps in tabular input mode

Create a customer journey step

To create a step in tabular input mode for a customer journey:

1. Click the Step tab.
2. Click New.
The Choose Object Type window appears.
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3. Select Steps and click OK.
The new step appears in the list of journey phases.

4. Click on the name of the step to update it.
The step created appears in the diagram outside of the phase area.

Create several steps simultaneously

To create several steps in tabular input mode simultaneously:
1. Click on the step starting from which you wish to create the other steps.
2. Click the Multiple Creation button.
A creation window appears.

Create ®
Concept: Steps

Number of steps: 1

Sequence of.. Steps

3. Enter the Number of Steps you wish to create.
4. Choose Sequenced Steps or Independent Steps.
5. Click OK.

w The steps are created but are not connected to a phase.

Organizing the customer journey steps in tabular input mode

By default, steps are not associated with phases and they are not sequenced.

Defining the sequencing of a customer journey

To define the sequencing order of the steps of a customer journey, you must specify
the list of predecessors at each step.

To specify the predecessor of a step of a customer journey from its diagram:

1. Click the Step tab to access the list of diagram steps.
2. Select the step concerned and click OK.
A window opens with the list of steps of the diagram that can be

connected.
3. Select the step concerned.
m  You can select several steps.

4. Click outside of the selection pane of the steps.
The organization of the steps in the diagram are automatically updated.
Connections are created between each other.
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Specify the phase of a customer journey step

To specify that a customer journey step is performed within the context of a journey
phase:
1. Click the Step tab to access the list of diagram steps.
2. Select the step that you want to connect to a phase and and click Phase.
Use the down arrow to easily access the list of customer journey phases.
3. Select a phase in the list proposed.
The step is moved to the swimlane that corresponds to the phase.

Defining the channels in a customer journey

A channel is used to identify the enterprise resources used by a
persona to achieve a step. For example, a channel can be a phone or

internet connexion.
The channels of a customer journey are also linked to the steps of the journey that
uses them.

To create a customer journey channel in tabular input mode

1. Click the Step tab to access the list of diagram steps.

2. Select the step that you want to connect to a channel and click Channel.
w  Use the down arrow to easily access the list of customer journey
channels and connect the step to a channel that already exists.

3. Click the right facing arrow and select the Create Channel command.

The Creation of Channel window appears.

4. Enter the Name.

5. Click OK to close this creation window.

The channel is created and appears in the list. The step is automatically
moved to the line that corresponds to the channel.

4o Sports holidays - Young
adult i
Search holidays

& Youngadult

@ Sports holidays

—

v
[ Ra—— Hﬂm"\;;;;;;ggﬁWHWMW WMJ

Diagram of customer journey with steps and channels
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Client expectations and painpoints

The expectations and painpoints are specific to each persona with respect to a
customer journey step.

Sports holidays - Young _
adult Expectations

&a Youngaduh

i Sports holidays

Web application

Adding persona expectations to customer journey mapping

An external org-unit is an external entity that exchanges flows with
the enterprise. Example: customer, supplier, government office.
The expectations of a customer journey are also connected to personas and they
must also be connected to the steps in the customer journey that use them.

m  The list of expectations of a customer journey is accessed from the
Characteristics properties window, in the Phases section.

w  The list of expectations of a persona is accessed from the
Customer Journey properties window of the persona, in the
Customer Expectations section.

w  For more details, see "Specifying the expectations of a persona”,
page 133.

To specify that a new customer expectation is connected to a customer journey:

1. Click the Step tab to access the list of steps in the customer journey.

2. Select the step that you wish to connect to an expectation and click in
the Expectations.
A window appears with the list of customer expectations connected to the
mapping of the customer journey.

w  To complete the list of expectations proposed, click Connect.

3. Click Add to create a new expectation.
The new customer expectation appears in the list of customer journey
expectations.

4. Change the name of the customer expectation.

5. Select the expectations that you want to connect to the step and click on
the outside of the selection window pane.
The customer expectations selected appear in the swimlane of the step.
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Defining customer painpoints

A painpoint describes the difficulties encountered by a persona
when carrying out a step in the customer journey.

To specify that a new painpoint is connected to a customer journey:

1.
2,

Click the Step tab to access the list of steps in the customer journey.
Select the step that you wish to connect to an expectation and click in
the Painpoints column.
A selection window appears with the list of painpoints connected to the
mapping of the customer journey.

w To complete the list of painpoints proposed, click Connect.
Click Add to create a new painpoint.
The new painpoint appears in the list of customer journey painpoints.
Specify the name of the painpoint.
Select the painpoints that you want to connect to the step and click on

the outside of the selection window pane.
The painpoints selected appear in the swimlane of the step.

The touchpoints and the business opportunities of a customer

journey

D A touchpoint describes an interaction between a persona and an
enterprise.

A touchpoint is used to identify the organizational elements, used during the
customer journey, that could have an impact on customer satisfaction. A touchpoint
is connected on the one hand to a step and its channels and painpoints, and on the
other hand to business improvement opportunities.

In the diagram, the touchpoints, the channels and the painpoints and the business
opportunities are in the same swimlane as the customer journey step.
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Creating a touchpoint in a customer journey

D A touchpoint describes an interaction between a persona and an
enterprise.

To create a touchpoint in a customer journey:

1.
2,

o

Click the Step tab to access the list of steps in the customer journey.
Select the step that you want to connect to a touchpoint and click in the
Touchpoint column.
A selection window appears with the list of touchpoints connected to the
mapping of the customer journey.

w  To complete the list of touchpoints proposed, click Connect.
Click Add to create a new touchpoint.
The new touchpoint appears in the list of touchpoints of the customer
journey.
To change the name of the touchpoint.
Select the touchpoints that you want to connect to the step and click on
the outside of the selection window pane.
The touchpoints selected appear in the swimlane of the step.
The step shape is modified.

Ask information

v

Step connected to a touchpoint
w  The list of touchpoints of a customer journey is accessed from the
Characteristics properties window, in the Touchpoint section.

w  The list of painpoints connected to a customer journey is accessed
from the Characteristics tab, in the Painpoints section.

w  For more details on painpoints, see "Defining customer painpoints”,
page 141.

Defining the business opportunities of a customer journey

An opportunity characterizes an improvement action for one of the
composite elements of the customer journey (steps, touchpoint).

To specify that a new business opportunity is connected to a customer journey:

1.
2,

Click the Step tab to access the list of steps in the customer journey.
Select the step that you wish to connect to a business opportunity and
click in the Opportunity column.

A window appears with the list of business opportunities connected to the
mapping of the customer journey.

w To complete the list of painpoints proposed, click Connect.

Click Add to create a new business opportunity.
The new business opportunity appears in the list of customer journey
opportunities.

4. Specify the name of the business opportunity.
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5. Select the business opportunity that you want to connect to the step and
click outside of the selection window pane.
The business opportunities selected appear in the swimlane of the step
directly under the touchpoints of the step and are automatically
connected.

w  The list of business opportunities connected to a customer journey
is accessed from the Characteristics tab, in the Business
Opportunities section.

Identifying a moment of truth

A moment of truth is a decisive step for the remainder of the
customer journey. Either customers believe that they cannot obtain

what they are searching for under the desired conditions and they are
not satisfied; Or, on the contrary, they believe that they have found
what they are looking for and continue the journey.
To specify the steps of a customer journey that constitute moments of truth:
1. Click the Step tab to access the list of steps in the customer journey.
2. Select the Moment of Truth column.
Check boxes appear on each row of the column.
3. Select the check box that corresponds to the step you wish to specify as
a moment of truth.
The step shape is modified.

Search holidays

(1]

Step declared as a moment of truth

w In the Characteristics tab of the properties window for the
selected steps, the Moment of Truth check box is also checked.

Creating Action Plans

Following the identification of possible improvements to a customer journey, it is
possible to create an action plan from a touchpoint.
An action plan comprises a series of actions, its objective being to
reduce risks and events that have a negative impact on company
activities.
To create an action plan from a customer journey touchpoint:
1. Click the Step tab to access the list of steps in the customer journey.
2. Select the step to which the touchpoint concerned is connected.

3. Click the Action plan column.
A selection window appears with the list of action plans connected to the

mapping of the customer journey.
m  To complete the list of touchpoints proposed, click Connect.
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4,

oo

Click Add to create a new action plan.

The new action plan is created in the list of action plans of the customer
journey.

Change the name of the action plan.

Select the action plans that you want to connect to the step and click
outside of the selection window pane.

The action plans selected appear in the swimlane of the step.

w  The list of action plans of a customer journey is accessed from the
Characteristics properties window, in the Plans section.

m  For more information on managing action plans, see "Action Plans
with HOPEX Business Process Analysis", page 171.
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ASSESSMENT OF A CUSTOMER JOURNEY

The objective of the HOPEX Customer Journey module is to describe your
customer journeys with a view to improving efficiency. By performing assessments,
you can acquire valuated information and compare it.

With HOPEX Customer Journey, assessments are made using questions attached
to channels. It is therefore possible to measure improvements made through the
implementation of touchpoints on the sensitive steps of the journey.

HOPEX Customer Journey is based on assessment functionalities to define the
questions and obtain the assessments of the steps of your customer journeys.

The following points are covered here:

"Defining questions for the assessment of a customer journey", page
145,

"Assessing a customer journey", page 146,

"Consolidating results and assessments", page 148.

Defining questions for the assessment of a customer journey

With HOPEX Customer Journey , you assess the tools used by the persona for a
customer journey. As a result, the questions are connected to the channels of the
customer journey steps. The assessment of the customer journey takes place via
questions that concerns each channel-step pair.

Creating Questions

To create a question:

1.
2,

Open the Customer journey navigation window.
Select Assessment > All Questions.
A tree with the list of Channels appears.
Click on the channel that interests you to display its pop-up menu and
select New > Question.
The Creation of a Question window appears.
Specify the Local Name of the question.
m  The local name of the question is not visible to the questionnaire
respondent.
Specify the Title, which represents the question as it appears in the
customer journey assessment questionnaire.
If necessary, specify:
e The Mandatory Element field (indicates the mandatory or optional
nature of the answer to this question).
e The Delegation Allowed field (specifies if the answer to this question
can be assigned to another person by delegation).
The Type of question is Combolist.
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8. Create the possible answers.

w  For more details, see "Entering possible answer values”, page 168.
9. Click OK.

Entering possible answer values

To create a possible answer value for a question:

1. Open the dialog box of the question that interests you.

2. In the Possible Answer Value section, click New.
A possible answer value creation window opens.

3. Enter the Name of the value.

4. Indicate the color associated with the answer value.
You have two possibilities:
e Specify a MetaPicture if you have one.

w The MetaPicture enables association of an image with an answer
value.

e Specify RGBColor.
5. In the Answer Value field, specify a strictly positive integer value that
will be used to calculate the value of the assessment.

m The lowest note corresponds to a very poor assessment and the
highest note corresponds to an excellent assessment.

w  For more details on calculating assessment values, see
"Consolidation rules”, page 148

w  You must create at least two possible answer values.
6. Click OK.

Assessing a customer journey

When the questions have been defined, the customer journey can be assessed.

Access the customer journeys for the assessments
Access to the customer journey is different depending on what you want to do:

To access the list of customer journeys that have never been assessed:
) Select Assessment > Non Assessed Customer Journeys.

To consult the results of the assessment consolidation of a customer journey:
) Select Assessment > All Assessed Customer Journeys.

w  For more details on calculating assessment values, see
"Consolidation rules”, page 148

To assess a customer journey that has already been assessed:
} Select Customer Journeys > All Customer Journeys.
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Answering questions for the assessment of a customer journey

To assess a customer journey for the first time:

1. Open the Customer journey navigation window.
2. Select Assessment > Customer Journey Non Assessed.
The list of non-assessed customer journeys is displayed.

m To access a customer journey that has already been assessed,
select Customer Journeys > All Customer Journeys.

3. Select the customer journey that interests you and click Assess.
The properties dialog box for the window appears.

4. Answer the question and click OK.

Selection of holidays

Ask information

Phone Service
Quality: Good hd
Reservation
Complete the customer information
Web application
Rapidity: | v
Proceed with |
(Empty)

Web appli Satisfactory

I very slow

Rapidity: M Quite slow

Validate the order
Web application

Rapidity: 5 v

m To assess a customer journey that has already been assessed:
open the Customer journey navigation pane, select Assessment >
All Assessed Customer Journeys and click Assess.
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Consolidation rules

Each answer to a question is associated with a percentage calculated using:
e the value defined in the Answer Value field of the chosen answer,
e the maximum value of possible answers,
e the minimum value of possible answers.
w  For more details on the values associated with answers, see
"Entering possible answer values", page 168.

In this way, the value of the answer that corresponds to the best assessment equals
100% and the value of the answer that corresponds the least equals 1%.

For example, if the best answer to the question "Rapidity of
the web application" is "Satisfactory" associated with a
value equal to 11, the "Very slow" assessment is associated
with a value equal to 1 and the intermediate assessment
"Quite slow" is associated with 3, then the value of the
"Quite slow" assessment equals 20%.

Overview

The assessment results presented in the diagrams, the lists and properties pages
are in general the values of the latest assessment.

Only the reports present average results. The calculation rules for averages are
always the same irrespective of the object:
) the average value of the assessments of an object is the average of the
assessment values of the object for a given period.

For example, if for the question "Rapidity of web
application" the first answer was "Satisfactory" (value
100%) and a second answer was "Too slow" (value 1%), then
the average value of assessments equals 50%.

Value of the latest assessment of a question

The value of the latest assessment of a question is used to calculate the values of
the last assessment of the steps for which the answers were given.

The value of the latest assessment of a question is the value of the percentage
calculated for the answer during the latest assessment.

In the example of the question concerning "Rapidity of the
web application", if the response "Satisfactory" was chosen
during the latest assessment, then the value of the latest
assessment of this question is 100%.
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Value of the latest assessment of a step

Each of the questions associated with a channel are asked for all steps that use the
channel.

For example, the web application channel is used for all the
steps in the "Holiday reservation" phase.

The questions on the "Application web" channel can deal with
its "Rapidity" and its "Conviviality"

The value of the latest assessment of a step is used to calculate the assessment
values of a channel if answers were given.

The value of the last assessment of a step is the average of the values of the latest
assessment of each of the questions relating to the step.

For example, the value of the "Proceed to payment" step is
the average calculated using the value of the latest
assessment given to the "Rapidity" and to "Conviviality".
Value of the latest assessment of a channel
The value of the latest assessment of a channel is the average of the values of the
latest assessment of each of the steps connected to the channel.
Value of the latest assessment of a customer journey

The value of the latest assessment of a customer journey is used to calculate the
assessment values of a customer journey group and a persona.

The value of the latest assessment of a customer journey is the average of the
values of the latest assessment of each of the steps in the customer journey.
Value of the latest assessment of a customer journey group

The value of the latest assessment of a customer journey group is the average of
the values of the latest assessment of the customer journey of the group.

Value of the latest assessment of a Persona

The value of the latest assessment of a persona is used to calculate the assessment
values of a persona group.

The value of the latest assessment of a persona is the average of the values of the
latest assessment of the customer journeys connected to the persona for a given
period of time.

Value of the latest assessment of a Persona Group

The value of the latest assessment of a persona group is the average of the values
of the latest assessment of the group persona.
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Consolidated results

The consolidated results on the customer journey are presented in:
e diagrams,

w  For more details, see "Representation of consolidated results in the
diagrams", page 150.

o ists,

w  For more details, see "Representation of consolidated results in the
lists", page 151.

e dedicated reports.

w  For more details, see "The reports available on a customer
journey", page 152.

Representation of consolidated results in the diagrams
After assessment of a customer journey, the shape of the steps in the customer
journey diagram is modified to present the results of the latest assessment of steps.

w  For more details on calculating the value of the assessment, see
"Value of the latest assessment of a step”, page 149

Mapping a journey after assessment
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Journey step Comment

Customer satisfaction very low

Customer satisfaction low
e
Customer satisfaction neutral
@)
Customer satisfaction high
©

Customer satisfaction very high

Customer satisfaction not assessed

Cust Jour

Presentation of the shape of steps differs according to the consolidated result of assessments.

Representation of consolidated results in the lists
After assessment of a customer journey, the consolidated results of the latest
assessment appears in the lists. For example:

e In the Assessment > All Assessed Customer Journeys folder,
e In the properties page for the customer journey in the Assessment tab.

w  For more details on calculating the value of the assessment, see
"Value of the latest assessment of a step"”, page 149
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THE REPORTS AVAILABLE ON A CUSTOMER JOURNEY

This paragraph presents the list of reports available from a customer process.

e "Global satisfaction", page 152

e "Improved scope", page 154

Global satisfaction

This report presents the results of the satisfaction of persona with the various
customer journeys.

Report parameters

Parameter Parameter type Constraints
Assessment "All assessment values" or Mandatory

values "Latest assessment values"

From Date Date Today’s date by default.
To Date Today’s date by default.

Persona satisfaction

The first chapter presents a summary view of the satisfaction of persona with the
customer journey for given dates.
e The x-axis carries the dates of the assessment period.
e The y-axis carries the value of the latest assessment of persona.
The table under the curve indicates the value of the latest assessment of

each persona at different dates.

m  For more details on calculating the satisfaction of a persona, see
"Value of the latest assessment of a Persona”, page 149.

e The figure presents a curve by persona and a curve that presents the
average.
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— Young adult

Average

0 T T 1
/25/2016 8/1/2016 8/8/2016 8/15/2016

Customer Journey Persona Assessment Date Customer Satisfaction
‘h Sports holidays - Young adult 2 Young adult 01/08/2016 Meutral

‘h Sports holidays - Young adult a Young adult 0710812016 Neutral

‘h Sports holidays - Young adult a Young adult 0910812016 . Very High

‘h Sports holidays - Young adult a Young adult 15/08/2016 . Very High

‘h Sports holidays - Young adult a Young adult 17/08/2016 . Very Low

Satisfaction of customer journey groups

The table is organized as follows:
e FEach row is associated with a customer journey group assessed between
the two dates given as a parameter.

w  The group expands to show the results of the customer journeys to
which they are connected.

e FEach column is associated with a persona
e The cells present the satisfaction of the persona with the corresponding
journey group (or with the customer journey itself).

w  For more details on calculating the satisfaction of the persona for a
customer journey, see "Value of the latest assessment of a customer
journey", page 149 and "Value of the latest assessment of a customer
journey group”, page 149.

2. Customer Journey Group satisfaction

&2 Young adult & Single pizza eater

1 Take away High
‘h Order pizza High
* Game day

‘h Ordering pizzas for a game event
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Improved scope

This report presents the assessment results with respect to the resources associated
with the touchpoints.

Report parameters

Parameter Parameter type Constraints

Assessment "All assessment values" or Mandatory

values "Latest assessment values"

From Date Date Mandatory, today’s date by default.
To Date Mandatory, today’s date by default.

Assessment of the scope

The first chapter of this report presents a bubble chart that is used to assess the
efficiency of the touchpoints with respect to the assessment period.
e Each bubble represents a touchpoint.
e The size of the bubble represents the number of customer journeys that
use the touchpoint resource.
e The color of the bubble represents the average value of the assessment
of the resource for the steps assessed.
e The x-axis shows the number of touchpoints to which the resource is
connected.
e The y-axis presents the average value of the assessment of the resource
for the steps assessed.

m The x-axis presents the same information as the colour of a bubble.
Thus, the red bubbles are at the bottom of the diagram and the green

bubbles are on top.
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The customer journey
The reports available on a customer journey
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The table under the bubble diagram specifies the value of the latest
assessment of each person at different dates.

w  For more details on calculating the satisfaction of a persona, see
"Value of the latest assessment of a customer journey", page 149.

Customer Journey Persona Assessment Date Customer Satisfaction
‘h' Sports holidays - Young adutt 2 Young adult 01/08/2016 Neutral

1" Sports holidays - Young adutt 4 Young adult 070812016 Neutral

‘h' Sports holidays - Young adutt 2 Young adult 02/08/2016 . ery High

1" Sports holidays - Young adutt 4 Young adult 150812018 . Very High
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The latest table of the report details the data presented in the bubble diagram.
e Each row is associated with a resource (if appropriate connected to a

il Planning Mgt
ik Store Manager

B Welcome client

number

of touchpoints).

e The first column specifies the average value of the assessment of the
resource for the steps assessed.

e The second column specifies the number of touchpoints to which the
resource is connected.

e The third column specifies the number of customer journeys to which the
resource is connected.

e The name of the customer journey that uses the resource is specified in
the fourth column.

e The fifth column specifies the percentage of steps noted as moments of
truth that use the resource.

e The last column draws up the list of channels to which the resource is
connected.
Customer satisfaction Number of Number of customer Parcours  Percentage of Canaux
value average~ touchpoints journey. client moment of truth concernés
550 10 10 ‘h Order A Phone
pizza
65.0 2.0 10 ey 00 % A Phone
pizza
75.0 1.0 10 e orger 100.0 % A Phone

pizza

w For more details on calculating the satisfaction a persona for a
customer journey, see "Consolidation rules”, page 148.
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MANAGING QUALITY

HOPEX Business Process Analysis offers functions that simplify creation and
maintenance of a quality system conforming to ISO 9000 standards. You can:

e Draw up your organizational processes graphically using organizational
process diagrams.

e Enter the characteristics specific to the quality problem.

e Synchronize your processes and the various chapters or themes of the
quality repository on which you are based (ISO 9001 standard, 2015
edition, etc.).

e Generate a quality manual automatically

Prerequisites to Use of Quality

An option is used to display the properties dedicated to the management of
processes quality.

To activate this option:
1. In the workspace, open the Options window.
2. In the left tree, select Business Process and Architecture Modeling:
3. Select the check box Quality Modeling.
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ORGANIZATIONAL PROCESS PROPERTIES

In the properties dialog box of an organizational process, the Quality tab allows you
to:

enter quality characteristics specific to processes.

indicate to which section of which repository the process you are

describing refers. In this way, the processes are associated with chapters
or themes so as to indicate their field of application.

Indicating Organizational Process Quality Characteristics

In the Details sub tab (Quality tab), you can enter characteristics relating to quality
issues.

m Quality ¥
—  Details
Process Frequency:
Organizational Process Type:
QA Organizational Process:

Organizational Process Class:

Application Date:
End of Validity Date: [
+  Texts
<+  Chapter

Organizational process types and classes
Two types of organizational process are managed:

e "General" organizational processes: involve the entire enterprise or
organization.

e "Specific" organizational processes: specific to a part of the enterprise or
to a product.

Organizational process classes proposed are:
e "Normal" organizational processes: describe the typical operations of the
enterprise.

e "Urgent" organizational processes: describe a fast track such as
providing speedier service to a customer.

e "Special" organizational processes: used for exceptional events such as
accidents.

HOPEX Business Process Analysis



Managing Quality
Organizational Process Properties

Other organizational process characteristics

The QA-Organizational Process field allows you to specify if the procedure forms
part of the Quality Assurance (external) or Quality System (internal) documentation
of the organization.
w  This option concerns the 1994 version of ISO 9001 standard.

The Frequency of the process can be:

e “On Request” (the process is applied when the event that triggers it

occurs).

e Daily, Weekly, Monthly, Twice a Month, Quarterly, or Annually.
The Application date and End of validity date of the process can also be
indicated.

w  The application and validity end dates are displayed using the
Windows default format. You can change this format in the Regional
Settings properties dialog box (short date).

To enter a date beyond the year 2000, you should select short date
format of type dd/MM/yyyy with four characters for the year.

Entering the texts of an organizational process

The Quality property page of an organizational process includes a Texts section
that allows you to enter different types of text (standard): “Application domain”,
“process object”, “references”, “definitions”, etc.

—  Texts

[A  Default font v

Specifying Context of the Quality Approach

The Quality property page of an organizational process includes a Chapters
section that allows you to specify the standard on which you are based for your
quality approach or certification.
m To have access to data relating to the standard ISO 9001 2015, you
must have imported the "ISO" Solution Pack. For more details, see

“Importing a Solution Pack ins HOPEX" in HOPEX Administration
guide.

The subtabs ISO 9001 and Other chapters correspond to different repositories
serving as the basis for your quality approach:
e 1ISO 9001
This sub-tab presents the 20 chapters (or requirements) of the ISO 9001
standard.
e Other chapters
This sub-tab concerns you if you are using another standard for your
quality approach or certification. The chapters that you may have created
will appear here.

w To create new chapters you must use the explorer.
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MESSAGE FLOW PROPERTIES

The Quality properties page allows you to specify characteristics of a message flow
related to quality.

Quality ¥
Collector Org-Unit:
Identification:
Message-Type:
Access:

Storage Time:
Storage Location:
Retention Time:
Retention Location:

Destruction:

The Message-Type list box enables characterization of the message flow: "External
Data", "Quality Record" or "Instruction".
The other fields allow you to enter additional indications for messages of “"Quality
record” type that are particularly important in documentation of your quality
system. Here you can define the controls needed for identification, storage,
retention time, etc.
According to the ISO 9000 standard, a "Record" is a "document
stating results achieved or providing evidence of activities performed”.
It can document traceability and provide evidence of the verification,
preventive action, and corrective action. It can consist of a form, report,

list of actions, etc. It can be written or saved on any data carrier.
Generally records need not be under revision control.
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ASSESSMENTS WITH HOPEX BUSINESS
PROCESS ANALYSIS

Questionnaires are used to obtain an assessment of the execution and performance of business and
organizational processes.

HOPEX Business Process Analysis uses assessment features to carry out assessments of your
business and organizational processes based on answers to standard questionnaires. In this way
you can improve their real and perceived quality.

w To access assessment examples described in this guide, you must
have imported data specific to process assessments, see Connecting to
HOPEX Business Process Analysis.

The following points are covered here:

v/ Assessment principles
v/ Assessing a process with HOPEX Business Process Analysis
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ASSESSMENT PRINCIPLES

Concepts Overview

Assessment is carried out using assessment questionnaires. In HOPEX Business
Process Analysis, these questionnaires are accessible directly. Results are then
aggregates according to predefined rules to present results so they can be used.

Assessments relate to process execution and performance.

L1 An assessment is a mechanism used to receive feedback

(qualitative or quantitative) from an identified population on identified
objects. The assessment is then supplemented by results analysis tools.

An assessment questionnaire is a list of questions relating to a
particular object and addressed to persons questioned.
The results of these assessments are then presented in reports. For more details,
see Execution and Performance Heatmap.

Criteria assessed with HOPEX Business Process Analysis

These characteristics relate to attribute values linked to process performance and
execution.

List of characteristics linked to process execution:
e Specification: assessment of quality of description of the object in

the repository.
e Knowledge: assessment of knowledge of the object by stakeholders.

e IT Support: assessment of application support of the object.

e Execution: this characteristic is a global assessment of object
execution. It is calculated from assessment of object specification,
knowledge and support.

List of characteristics linked to process performance:
e Effectiveness: characterizes effectiveness of object operation
e Business Value: characterizes business value of the object.
e Risk: characterizes risks concerning the object.
e Performance: this characteristic is a global assessment of process
performance. It is calculated from assessment of process business
value, effectiveness and risk.
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Assessments With HOPEX Business Process Analysis .
Assessing a process with HOPEX Business Process Analysis .

ASSESSING A PROCESS WITH HOPEX BUSINESS PROCESS
ANALYSIS

Accessing the Process Assessment with HOPEX Business Process
Analysis

The properties pages of an organizational process (or a business process), enables
access to different forms of Assessment.

Assessment Global Assessment

Action Plans Direct Assessment (Execution)
Reporting Direct Assessment (Performance)
Object life Specific Questions (Execution)

Specific Questions (Performance)

The following choices are available:

e Global Assessment: to attribute values to the assessment criteria of
the process.
See Global assessment.

e Direct Assessment (Execution) and Direct Assessment
(Performance): enables expert users to assess the execution and
performance criteria for a process in its different use contexts.

See Direct Assessment.

e Specific Questions (Execution) and Specific Questions
(Performance): to add questions to existing assessment
questionnaires.

See Specific questions.

Completed assessments are used to obtain summary reports.

w  For more details on this summary report, see Execution and
Performance Heatmap.
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Global assessment

The Assessment > Global assessment property page of an organizational

process allows an expert user to specify values of attributes linked to assessed
characteristics.

[ o ] - Global A -
—  Execution
Design : Il Very Poor v
Knowledge : | [l Very Well Known -
IT Support : Good b
—  Performance
Efficiency : Il Very High

Business Value: |l very Low

Risk : High

Direct Assessment

You can create new assessments to globally assess an organizational process on all
the organizational contexts to which it is connected (i.e. entities).

This is an "expert view" assessment.

Creating direct assessments (Execution)

To create a direct execution campaign:

1. Open the Assessment > Specific Questions (Execution) property
page of the process that interests you.

164 HOPEX Business Process Analysis



Assessments With HOPEX Business Process Analysis
Assessing a process with HOPEX Business Process Analysis

2. Click the Evaluate button.
The assessment questionnaire page appears.

Create new evaluation - Direct answers €
4+  Diagram
—  Description

Map and description of the process is exhaustive and up to date in process repository :

v

Process stakeholders are well aware of their requested contribution to the process 2: v

The process is 1 as it is described in process repository : v

with other p are identified, listed and qualified 2: v

Maps and d ion of the p is available to process stakeholders and to the other persons of the company 2: v
—  Operation

How does this process enable you to reach objectives assigned to you 7:

v

Are your clients (internal or external) satisfied of process course 2: v
Are your clients (internal or external) satisfied of process results 2: v
Do you often observe malfunction during process execution - v

Identify the degree to which this process is supported by application functionalities ?: v

+  Attachments

—  Measure Date

Date: * 12/19/2019

3. Select the contexts in which the process is to be assessed, then click
Next.

w The contexts are available only if there is more than one.
Specify the values for the questionnaire characteristics:
(Optional) Add Attachments.
Check the Assessment Date.
Click OK.
An assessment is created.

No ok

Creating direct assessments (Performance)

You create an assessment of the performance of your process in the same way as
for an execution assessment (see Creating direct assessments (Execution)).
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The standard questionnaire for the performance appears.

Create new evaluation - Direct answers €
—  Business Value
Performance indicators are defined and updated according to company objectives ?: v
What is process contribution to company objectives 2: v
Evaluate the process direct or indirect business value for the company ?: v
Identify the degree to which this process meets business needs ?: v
How flexible the process is to satisfy changing business / user requirements ?: v

How does this process enable you to reach objectives assigned to you ?: v

—  Efficiency
Potential improvement (Cost) - v
Potential improvement (Quality) ?: ]
Potential improvement (Delay) ?: v
Potential improvement (Complexity) ?: v

Are your clients (internal or external) satisfied of process course 2: ~

Are your clients (internal or extemal) satisfied of process results 2- v

—  Risks

What is the impact to the process if sustaining applications was not present 2: v

Arerisks iated to process ion identified 2: ~ |

Specific questions

You can add new questions to your questionnaires for your processes.

Your question then appears in the associated questionnaire in the corresponding
section: "Process execution" or "Process performance".

« | Process Execution
This is my question: d
v 0K

» no
O nja

OK/NO/NA specific question type

Creating a specific question (Execution)

To create a specific execution question:

1. Open the Assessment > Specific Questions (Execution) property
page of the process that interests you.

2. Click the New button.
The question creation page appears.

166 HOPEX Business Process Analysis



Assessments With HOPEX Business Process Analysis
Assessing a process with HOPEX Business Process Analysis

3. Specify the Local Name of the question.

m  The local name of the question is not visible to the questionnaire
respondent.

4. Select the Type of question enabling specification of the answer format.

m  Depending on the Type of question, an Answer section appears.
Answers of "Multiple answers" type require require manual creation of
answers. For more details, see Question Types.

5. Specify the Title, which represents the question as it appears in the
questionnaire.
6. You can indicate:
e The Mandatory Element field (indicates the mandatory or optional
nature of the answer to this question).
e The Delegation Allowed field (specifies if the answer to this question
can be assigned to another person by delegation).
7. Click OK.

Question Types

The question types that can be used to directly enter an answer are listed below.

e Text: to enter the text.
e String: to enter a string of characters in a field.

w If you must display your answer in more than one field/row, select
the Multiple Answer Type value.

e Multiple Answer Type: to display several answer fields for the same
question.

Example of use: to enter an address you may need several
fields.

w This type of answer requires creation of answer values. For more
details, see Entering possible answer values.

Signed Number: to enter a negative or positive number
Timespan: to enter a timespan

Floating: to enter a a floating point number.
Percentage: to enter a percentage.

Integer: to enter a short integer.

1 =
e Date: to enter a date using a calendar

4/25/2014 3
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The types of questions used to select a value using predefined suggestions are listed
below.
e OK/NO/NA: provides a drop-down list containing three values:
e OK
e NO
e N/A (Not Applicable)

h

(Empty)
v' 0K
X NO
O N/A

e Drop-down List: to select a value from a drop-down list.

(Empty)
- Value 1
. Value 2
. Value 3
B value 4

w  This type of answer requires creation of answer values. For more
details, see Entering possible answer values.

e Radio button (: to display vertical radio buttons in the answer.

@ Value 1
Value 2
Value 3

w  This type of answer requires creation of answer values. For more
details, see Entering possible answer values.

Entering possible answer values

You must specify the answer values possible if you have defined the following
question types:

e multiple answer

e drop-down lists

e radio buttons (vertical)
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Assessing a process with HOPEX Business Process Analysis

In this case, an Internal Default Value field and a Possible Answer Value
section open automatically in the question creation page.

w  For more details on managing questionnaires, see Creating Possible
Answer Values .

Creating Possible Answer Values
In this case, an Internal Default Value section opens automatically in the question
creation page.

To create a possible answer value:

1. In the Possible Answer Value section, click New.
A possible answer value creation window opens.

2. In the Answer Value field, specify a value.
w This value can be used by quotation rules.

3. Indicate the color associated with the answer value.
You have two possibilities:

e Specify a MetaPicture if you have one.

m The MetaPicture enables association of an image with an answer
value.

e Specify RGBColor.

Creation of Possible Answer Value - Characteristics ®
Local name: Possible Answer Value-1
Owner: Question-7 (Unique Value)
RGBColor: v
Answer Value:
MetaPicture: >

0K Cancel

4. Click OK.
w  You must create at least two possible answer values.

Defining an answer value by default in the event of a non-answer

You can allocate an internal default value for the drop-down list and radio button
type questions. This value is used if the respondent omits to answer a question.

To specify an internal value by default:
} In the properties page for the question, specify the Internal Default
Value field.

Creating a specific question (Performance)
You create a question specific to the performance of your process in the same way
as you do for an execution assessment (see Creating a specific question
(Execution)).
The question then appears in the direct assessment questionnaire (Performance).
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ACTION PLANS WITH HOPEX BUSINESS
PROCESS ANALYSIS

HOPEX Business Process Analysis allows you to specify, implement and follow up action plans
defined for managing, for example, a Customer Journey.

An action plan comprises a series of actions, its objective being to
reduce risks and events that have a negative impact on company

activities.
The following points are covered here:

v/ "Managing Action Plans with HOPEX Business Process Analysis", page 171
v "Managing actions with HOPEX Business Process Analysis", page 172

Managing Action Plans with HOPEX Business Process Analysis

An Action plan can be set up, for example, for improvement of a Customer Journey.

An action plan comprises a series of actions, its objective being to

reduce risks and events that have a negative impact on company
activities.

Creating Action Plans with HOPEX Business Process Analysis

To create an action plan from the Transformation navigation pane:
1. Select Corrective Action Plans > Action Plans.
2. Select My Action Plans tab.
3. Click New.
The new action plan appears in the list.

4. Change the name of the action plan.

You can also create or connect an action plan from the Action Plans property page
of an organizational process, for example. The object used to connect the action
plan appears in the Scope section of the Characteristics property page of the
action plan.

w To create an action plan from a Customer Journey, see "Creating
Action Plans", page 143.
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Characterizing Action Plans

w  For more details on action plans characteristics, see chapter
"Supplementing Action Plan Information" in the HOPEX Common
Features guide.

Action Plans execution with HOPEX Business Process Analysis

During the execution, an action plan takes different states. Passage between states
is submitted for the approval of the action plan owner or the action plan approver.

w  For more details on an action plan execution, see the, chapter
"Action plan execution" in the HOPEX Common Featuresguide.

With HOPEX Business Process Analysis, actions can be created as long as the
action plan is not closed.

w  For more details, see "Managing actions with HOPEX Business
Process Analysis", page 172.

Having specified the characteristics of a new action plan, the creator can: Send the
action plan to the “Approver” user.
The action plan "Approver" user can: Reject or Start the action plan.

When the action plan actions are closed, the "Owner” user must Close the action
plan.

After having consulted action plan follow-up reports, the "Approver"” user can: Close
or Reopen the action plan for complementary actions.

Preparing the action plan progress follow-Up

Action plan progress is specified at periodic dates by the action plan responsible
user.

HOPEX Business Process Analysis offers the opportunity to regularly remind the
action plan owner user by email to update the progress of his action plan using a
steering calendar.

w  For more details on an action plan execution, see the, chapter
"Action plan execution" in the HOPEX Common Featuresguide.

Managing actions with HOPEX Business Process Analysis

With HOPEX Business Process Analysis, the action plan Owner can propose and
assigning actions corresponding to the execution of the action plan.
An action is included in an action plan and represents a
transformation or processing in an organization or system.
To create actions, the action plan status must be "In progress", that is it has been
validated by the “Approver” user.

w For more details on the actions management, see "Managing
action” chapter in guide HOPEX Common Features.



HOPEX BUSINESS PROCESS ANALYSIS
REPORTS

HOPEX Business Process Analysis

offers analysis and follow-up of implementation of the business architecture evolutions of your
enterprise. HOPEX Suite uses reports to group sets of repository objects and study their
interactions.

w  For more details on operation of reports, see the HOPEX Common
Features guide, "Generating Reports".

Report templates proposed as standard by HOPEX Business Process Analysis offer various
analysis presentation possibilities.

The following points are covered here:

"Managing Processes", page 176.
"Exchange Balance", page 178.
"Process Analysis", page 181.
"Risk Management", page 203.

ANENENEN
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MANAGING PROCESSES

This paragraph presents the list of reports available from a process.
e "Process Support Table", page 176
e "Geographical Process Support Table", page 177

Process Support Table

This report describes which business applications support processes, and for which
org-units.

Cells contain offerings of the business process which:

e contain the product of the column,
e have as source or target a business process participant assigned to the
org-unit in the row.

This report also displays the business or organizational processes that are source or
target of the offering.

w  For more details on the use of products and offerings, see the
HOPEX Business Process Analysis guide.

Quotation#*

S
3
]
o
c
]
[&]

World@Hand Employee

HR Manager

il Employer

! World@Hand Vendor

_ & External Vendor -—= Short Term Procurement _ & External Vendor --= Short Term Procurement
- & Short Term Procurement - & Short Term Procurement

w  This matrix is displayed in the Products x Markets tab of the
business process.

Report parameters

Parameter Parameter type

Constraints
Object Business At least one object mandatory.
processes
Object Org Unit

At least one object mandatory.
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HOPEX Business Process Analysis Reports ;

Managing Processes

Geographical Process Support Table

This report describes which business applications support processes, and for which
geographical sectors.

Report parameters

Parameter Parameter type Constraints

Site Site At least one Site mandatory.

Object Business At least one Process mandatory.
processes
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EXCHANGE BALANCE

Exchange

Legend:

FFE4s FRYHEPS

Balanced
Items v
3 Conduct

Combat
Assessment

The incoming information element is managed around the balanced item.

The incoming information element is managed inside the balanced item.

The incoming information element is managed both around and inside the balanced item.
The outgoing information element is managed around the balanced tem

The outgoing information element is managed inside the balanced itern.

The outgoing information element is managed both around and inside the balanced tem,

The around exchange is coming in the balanced item.
The inside exchange is coming in the balanced item,
The around exchange is going out the balanced tem.

The inside exchange is going out the balanced item.

Balance Between Organizational Processes

The exchange balance between functional processes report controls consistency of
exchange design. A comparison of all incoming and outgoing exchanges defined
inside and outside functional processes identifies elements missing in the design, or
those that are unnecessary.

Information Elements Around Exchanges Inside Exchanges
E] T Re-strike &) Recommend E ~ Re-strike
Recommendation Restnke Recornmendation

This report enables consistency check of exchanges defined within the
organizational process with exchanges sent and received from the exterior.

Different icons are used to symbolize exchange type: message, flow or interaction.
These icons enable identification that exchanges between interior and exterior are
balanced.

This report is presented in the form of a table, rows of which are organizational
processes defined as parameters.

Report parameters

Parameter Parameter type Constraints

Object Organizational At least one object mandatory.
Process
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HOPEX Business Process Analysis Reports

Exchange Balance

Value Stream Exchange Balance

Like report "Exchange Balance Between Organizational Processes", page 178, this
report checks consistency of design of exchanges between value streams.

The following table shows for each operational activity the balance between around and inside information elements incoming or

outgoing the operational activity.

Legend:

The incoming information elerent is managed around the balanced iterm.

The incoming information element is managed inside the balanced item.

The outgoing information elerment is managed around the balanced itemn.

The outgoing information element is managed inside the balanced item.

The around exchange is coming in the balanced item.

The inside exchange is coming in the balanced itemn. L

The incoming information element is managed both around and inside the balanced itern.

The outgoing information element is managed both around and inside the balanced item.

HFTE FEFHES

The around exchange is going out the balanced item.

The inside exchange is going out the balanced item.

Exchange Balance
Balanced Items v

(@ Activate Search &
Rescue

@

Information Elements

Around Exchanges

SAR Alert =

Receive #{| .+ Receive Alert o--

Inside Exchanges

4 Process

Bl @ recaive

Alert = Bctivate Interface o--> Search
{ @ Activate ] Search & Rescue Receive and
Search & Search and Rescue
Rescue Rescue (S4R) (SAR)
alert alert
@ Conduct Search $] @ areaidentifiedto | @ Provide #{| .3 Provide Material | .- Process Pl @ assess
Reconnalssance recon Material and Other Interface o--> incident
{ @ Conduct Search )} and Support 0--> Assess incident site
S ReconnAiSsancs Other Conduct Search site
Support Reconnaissance
B’ [® Search sites -4 Conduct Search H“‘ (&) Search () Develop :l 4 Develop map
identified and Reconnaissance o-- map of of search area
prioritized > Search search 0--> Process
area Interface
@ Cemobilize / ] [ Victim not found @ Search #{| ...p Search o-->
Redeploy Demobilize /
{ @0 Demobilize /) Redeploy
Redeploy
Report parameters
Parameter Parameter type Constraints
Object optional At least one object mandatory.
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Exchange Balance Between Business Processes

Like report "Exchange Balance Between Organizational Processes", page 178, this
report checks consistency of design of exchanges between business processes.

Report parameters

Parameter Parameter type Constraints

Object Business At least one object mandatory.
processes

Value steps Exchange Balance

Like report "Exchange Balance Between Organizational Processes", page 178, this
report checks consistency of design of exchanges between value steps.

Report parameters

Parameter

Parameter type

Constraints

Object

Value step

At least one object mandatory.

Exchange Conformity Between Businesses

The report on conformity of exchanges between businesses checks that exchanges

between businesses are consistent with exchanges in processes that describe how
its elements behave.

Report parameters

Parameter

Parameter type

Constraints

Object

Business function

At least one object mandatory.
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HOPEX Business Process Analysis Reports ;
Process Analysis .

PROCESS ANALYSIS

This paragraph presents the list of reports available from a process.

"Business Process Automation", page 181

"Process Supervision", page 184

"Automated Process Supervision", page 184

"Process Functional Analysis", page 185

"BPMN Business Process", page 186

"BPMN Value chain", page 186

"BPMN Organizational Process", page 187

"Support of Processes by Applications Table (Statistics)", page 187
"Managing RACI (BPMN)", page 188

"Business Process RACI Matrix (BPMN)", page 190

"Business Process and Sub-Process RACI Matrix (BPMN)", page 192
"Organizational Process RACI Matrix (BPMN)", page 192
"Organizational Process and sub-processes RACI Matrix (BPMN)", page
193

"Org-Unit RACI Matrix (BPMN)", page 193

"Org-Unit and owned org-units RACI Matrix (BPMN)", page 193
"Business Process Products x Markets Matrix (BPMN)", page 193
"Products x Markets Matrix (BPMN)", page 194

"Business Process Contextualization Matrix (BPMN)", page 195
"Contextualization Matrix (BPMN)", page 195

"Execution and Performance Heatmap", page 195

"Org-Unit Analysis", page 199

"Site Analysis", page 202

Business Process Automation

This report enables detection of potential improvements in the information system
in its support of human resource activities.

The human activity analyzed comprises the set of operations executed by one or
several org-units. This set can be defined in different ways:

Processes or processes folder: in this case, processes are used to find all
operations contained in the processes that implement them.
Operations: a set of operations can be given directly. This set can also be
specified by a query or a query instance (for example all operations using
at least two IT services).

Org-units or org-units folder: in this case the set of operations is built
from the operations executed by these org-units.
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Comparison of exchanges at process and IT levels

This report explains how the information system can be improved related to the
processes it uses.

Search criteria are based on information exchanges carried out at process level that
are not delegated to IT services.

«| Application Scope

The scope constraining the set of analyzed applications.
This scope is opticnal, o if no scope is set, the analysis report retrieves all applications helping performing the operations.

Parameter Values
=  Name Value

1 &/ Application Scope [ maintenance vehicle System

Process and IT Service Exchanges Comparison B

Each row of the table below shows a couple of ocperations exchanging information whereas the supporting 1T services are not exchanging information at all.

Source operation v Target operation v Diagram list
[T Body problem (™) Breakdown determination: Is Car Diagram list
overview Reparable?
MName v

Breakdown Analysis (World@Hand: :MEGA Notation Diagrams::Car Rental Business) - Flowchart with
IT Services

@ Breakdown Analysis (World@Hand: :MEGA Notation Diagrams::Car Rental Business) - Flowchart

[ Determine problem (™ Retrieve breakdown body information Diagram list
type
MName v
@ Car Repair (World@Hand::MEGA Motation Diagrams::Car Rental Business) - Flowchart with IT
Services

Car Repair (World@Hand::MEGA Motation Diagrams::Car Rental Business) - Flowchart

This report functions on organizational process operations, successively processing
the following points:
1. analysis of the content of messages, message flows or shared objects
exchanged directly or indirectly between operations,
2. analysis of services used by operations,
3. verification that exchanges between services are consistent with
contents.

Querying IT services

IT services that can be used by process operations are found using common
functionalities attached to services and operations.
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Process Analysis

All process operations are displayed so as to list those that are supported by IT
services, those that could be supported using existing services, and those that
require design of new services.

IT Services Research F

Operation
i) Body problem overview

i) Breakdown determination: Is Car

Reparable?
i) Determine problem type

[ Engine problem overview

Expected functionalities

4 Input a Breakdown Analysis

% Input a Breakdown Determination

2 Input a Breakdown Analysis

Related services

% Breakdown Znalysis Report
Form

% Breakdown Determination
Form

% Repair Order Scheduler

¥ Breakdown Analysis Report

Form
[T Fix tire problem
() Prepare estimate, task and vehicle loan ¥ Estimate Form
[ Prepare invoice & Input a Car Repairing Invoice % Invoice Form

% Print Car Repairing Invoice

Report parameters

Parameter Parameter type Constraints

Human activ- Process, operation or org- At least one object mandatory.

ity unit.

Scope? Application Not mandatory.

w  Application scope indicates the scope restricting all applications
analyzed. This scope is optional. If it has not been mentioned, the
analysis report finds all applications used to execute operations.
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Process Supervision

This report finds indicators and dashboards dedicated to business or functional
processes.

Procurement - Business Process Monitoring

[Add a comment]
1. Indicators Evaluating the Business Processes 9 @
[Add a comment for this chapter]
Aggregated Indicator
Status Indicator Name Walue Indicator Status
555 Business Partner Satisfaction 50 u Unsatisfactory
aEb Supplier Diversity 17 D Operational
(& Short Term Procurement
@ Purchase Goods & Services
B Contract Megotiation . Critical 555 Contract Savings 1.5m a Operational
aEb Budget Attainment 30 . Critical
550 Contract Document Quality 65 D Warning
555 Manage Contract Expiration 10 a Operational
aEb Contract Under Negotiation 25 D Operational
550 Contract to Auditor 3 D Warning
) Quotation : % Supplier Quality 92 Operational
Requisition u Unsatisfactory a
Js Performing Time / Processing 52 u Unsatisfactory
Time
@ Purchase Goods & Services u Unsatisfactory ég; Performing Time / Processing 52 u Unsatisfactory
Time
() Quotation Requisition & Contract Negotiation u Unsatisfactory ng Performing Time / Processing 52 u Unsatisfactory
Time
@ Contract Negotiation [l critical s Contract Savings 1.5m @ operational
Jw Budget Attainment 30 . Critical
33 Contract Document Quality 65 D Warning
J Manage Contract Expiration i0 @ operational
Jw Contract Under Negotiation 25 a Operational
33 Contract to Auditor 3 D Warning
Report parameters
Parameter Parameter type Constraints
Object Business At least one object mandatory.
processes
optional

Automated Process Supervision

Like report "Process Functional Analysis", page 185, this report contains indicators
and dashboards dedicated to supervision of system processes.
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Process Analysis .

Report parameters
Parameter Parameter type Constraints
Object System process At least one object mandatory.

Process Functional Analysis

This report is designed to compare a group of processes providing functionalities
with a set of expected functionalities (defined in functional scope).

The functional scope determines which functionalities are expected to achieve a
given objective. It comprises functionalities that can be defined from processes or
businesses. We therefore find all linked functionalities.

Report parameters

Parameter Parameter type Constraints

Functional Business, process, function- | At least one object mandatory.
scope alities, operation

Process ana- Business, process, operation | At least one object mandatory.
lyzed

w The "Process analyzed' parameter indicates the group of processes

compared to the functional scope. It can also be applied to business
functions or processes.
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BPMN Business Process

This report describes a business process,

its structure, its exchanges with other

processes and with external participants, as well as detail of the products it supplies.

Products
Source Offering Destination
[ External Vendor (EN) |48 External Vendor —= Short Term Procurement | (&) Short Term Procurement
Product Product type
™ contract
B cuotation
The process I1s implemented with
Process type i
Functional @ Purchase Goods & Services The Purchase Goods & Services functional process describes how the Short Term Procurement business
Process organizational, regional or system consideration.
Organizational :
e ) Goods Purchasing
Organizational
Process @) Goods and Services Procurement
Organizational @ Purchase Goods & Services The Purchase Goods & Services organizational process describes how the United States office is running the Short Term Procuremer
Process -out ERP.
Bystem .
et Purchase Goods & Services (ERP)
Implementation context
0 i
=5 Contexiualization | §) Purchase Goods & Services Purchase Goods & Services (ERP)
= Contextualization | (F) Purchase Goods & Services | £ United States @) Purchase Goods & Services
=5 Contextualization | (7) Purchase Goods & Services | = United Kingdom @ Goods Purchasing %

Report parameters

Parameter Parameter type

Constraints

Object Business
processes

One object mandatory.

BPMN Value chain

Like report "BPMN Business Process",

page 186, this report describes an

organizational process, its template and its participants, as well as the value steps
for which each participant is responsible. This analysis also presents exchanges,

systems used to support value steps and
execution.

the risks encountered during process
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Report parameters
Parameter Parameter type Constraints
Object optional One object mandatory.

BPMN Organizational Process

Like report "BPMN Business Process", page 186, this report describes an
organizational process, its template and its participants, as well as the activities for
which each participant is responsible. This analysis also presents exchanges,
systems used to support activities and the risks encountered during process

execution.

Report parameters

Parameter Parameter type Constraints

Object Organizational One object mandatory.
Process

Support of Processes by Applications Table (Statistics)

This report describes which business applications support business or organizational
processes.

An organizational process is considered as supported by an application if this
process or one of its sub-processes or one of their operations is connected to this
application or to one of its sub-applications or to one of their application services.

A business process is considered as supported by an application if this business
process or one of its sub-processes or one of their organizational processes or one
of their sub-processes or one of their operations is connected to this application or
to one of its sub-applications or to one of their application services.

In a report of this type, applications are broken down into several categories:

e A process can be supported by zero (Orphan), one (Unique) or several
(Mule) applications.

e An application can support zero (Gap), one (Supported) or several
(Pivot) processes.
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The number of components of each category is presented:

e as stacked bars.
e as pie charts.

Application
EPMN Process
100 120

o 20 40 B0 80

B Gaps / Orphans
E Supported / Unigue
M Hogs / Mules

B BPMN Process

8 Application

B Gaps / Orphans:
16.67%

E Supported /
Unique: 66.67%

M Hogs / Mules:

16.67%

B Gaps/ Orphans:
33.33%

E Supported /
Unique: 0.00%

M Hogs / Mules:

66.67%

g Uplate Catalog - To Be -E Purchasing System z
3 Pay The Suppliers £ APPCO.com
© S0 - Financial Cycles B Catalog Managemenit
: Contract Megatiation E‘ 0 2 4
g Andgedaiaiie BPMH Process
= Process b 7 1
Application
Report parameters
Parameter Parameter type Constraints
Processes Business At least one object mandatory.
processes
Application Application At least one object mandatory.

Managing RACI (BPMN)

This report displays a matrix with org-units in columns and organizational processes

operations in rows.
w  For more details on managing RACI, see "Consulting reports
associated with org-units", page 114.
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Process Analysis

Cells of this matrix are filled with a letter representing responsibility of the org-unit
in the process (or operation):
e (A) for Accountable
(R) for Responsible
(R/A) for Responsible/Accountable
(C) for Consulted
(I) for Informed

| & & i
- e - o
c = = @
@ @ @ o
£ £ £ -
= 1= [ o
3 a g o
iy @ o
o o =]
@ = wi
8 12 |2
< B w
o i
=
m
0
e
o
£
=1
0
3
]
@ Deliver Vacation Business
& Invoice Customer (A)
& vacation Package Booking (a)
& vacation Package Delivery (a)
& vacation Request Formalization (a)

This value can be automatically proposed when a participant assigned to the org-
unit executes the operation or organizational process. It can be modified or
confirmed by the user.

A warning is displayed when the org-unit executing an operation or responsible for
a process is not connected via an intermediary participant to this operation or
process.
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If you click button , the context of the responsibility of the org-unit is indicated.
You can view:

e the name of the participant to which the org-unit is assigned
e the name of the process that is owner of the participant

58
=
a
-
D
(u
i
O
(7]
=
L
m
e
2
=
[
& process Purchase Request a
m Purchasing Department ] St
Report parameters
Parameter Parameter type Constraints
Org-unit (in Org Unit At least one object mandatory.
columns)
Process (in Organizational process or At least one object mandatory.
rows) operation

Business Process RACI Matrix (BPMN)

This report is a matrix presenting the RACI value of org-units presented in columns
related to operations and/or organizational processes presented in rows.

The org-units and organizational processes presented are directly connected to
business processes specified as parameters.

w To generate a matrix to search for organizational processes and
operations in depth, you must use report "Business Process and Sub-
Process RACI Matrix (BPMN)", page 192.

Cells of this matrix are filled with a letter representing responsibility of the org-unit
in the process (or operation):

e (A) for Accountable

e (R) for Responsible

e (R/A) for Responsible/Accountable

e (C) for Consulted
(I) for Informed
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If you click button

You can view:

e the name of the participant to which the org-unit is assigned

HOPEX Business Process Analysis Reports

& & & i
- e - o
c = = @
o @ o o
£ £ £ -
= = 1= o
2 2 2 o
iy @ o
=1 =1 o
@ = wi
o S @
et m
2 B @
o i
=
m
0
w
o
£
=1
@
3
]
@ Deliver Vacation Business
& Invoice Customer A
& vacation Package Booking (A)
& vacation Package Delivery (a)
& vacation Request Formalization (a)

e the name of the process that is owner of the participant

Purchasing Department g

& process Purchase Request

&

M Purchasing Department @ Standard Purchase Process

Report parameters

Process Analysis

, the context of the responsibility of the org-unit is indicated.

Parameter

Parameter type

Constraints

Object

Business process

At least one object mandatory.
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Business Process and Sub-Process RACI Matrix (BPMN)

Like report "Business Process RACI Matrix (BPMN)", page 190, this report describes
a matrix presenting the RACI value of org-units presented in columns related to
operations and/or organizational processes presented in rows.

The org-units and organizational processes presented are connected to business
processes with a depth level specified in parameters.

Defining matrix depth level
You can choose to increase object query depth.

To define depth level of the matrix:
1. Open the properties of the report.
2. Select the Parameters tab.
3. In the Levels field, indicate the value that interests you.
w  If you enter value "2", the matrix will query sub-sub-processes of

the selected process. Beyond value "3", the matrix will query all
processes located below the selected process, whatever the level.

4. Click Apply.
The report is accessible in the Reports Tab.

w If you modify setting values, remember to refresh the generated

report.
Report parameters
Parameter Parameter type Constraints
Object Business process At least one object mandatory.
Level Integer

Organizational Process RACI Matrix (BPMN)

Like report "Business Process RACI Matrix (BPMN)", page 190, this report describes
a matrix presenting the RACI value of org-units presented in columns related to
organizational processes presented in rows.

w To generate a matrix to search for organizational processes and
operations in depth, you must use report "Organizational Process and
sub-processes RACI Matrix (BPMN)", page 193.
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Organizational Process and sub-processes RACI Matrix (BPMN)

Like report "Business Process and Sub-Process RACI Matrix (BPMN)", page 192, this
report describes a matrix presenting the RACI value of org-units presented in
columns related to operations and/or organizational processes presented in rows.

Org-Unit RACI Matrix (BPMN)

Like report "Business Process RACI Matrix (BPMN)", page 190, this report describes
a matrix presenting the RACI value of org-units presented in columns related to
operations and organizational processes presented in rows.

This report automatically specifies matrix rows and columns with objects connected
to objects specified as parameters.

w To generate a matrix to search for organizational processes and
operations in depth, you must use report "Business Process and Sub-
Process RACI Matrix (BPMN)", page 192.

Org-Unit and owned org-units RACI Matrix (BPMN)

Like report "Business Process and Sub-Process RACI Matrix (BPMN)", page 192, this
report describes a matrix presenting the RACI value of org-units presented in
columns related to operations and/or organizational processes presented in rows.

The second parameter of this report indicates the number N of the depth level of
search for sub-org-units. If this number is not indicated, the complete hierarchy of
sub-org-units is specified.

The report searches for all sub-org-units of the given org-unit given as parameter
to N levels and adds this org-unit. It presents in columns the org-units found, and
in rows the operations or organizational processes associated with these org-units,
with the RACI value in the cell.

Business Process Products x Markets Matrix (BPMN)

This report presents products of offers of business process displayed in columns.
Or-units of business process external participants are displayed in rows.

Cells contain offerings of the business process which:

e contain the product of the column,
e have as source or target a business process participant assigned to the
org-unit in the row.
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This report also displays the business or organizational processes that are source or
target of the offering.

w  For more details on the use of products and offerings, see the

guide MEGA Process BPMN Edition, "Representing Product Offerings”
chapter.

-
c
-
™
=
=]
5
(2]

Contractf?

World@Hand Vendor - ' External Vendor —= Short Term Procurement _ W External Vendor —= Short Term Procurement

- & Short Term Procurement - & Short Term Procurement

w This matrix is displayed in the Products x Markets tab of the
business process.

Report parameters
Parameter Parameter type Constraints
Object Business process At least one object mandatory.

Products x Markets Matrix (BPMN)

Like report "Business Process Products x Markets Matrix (BPMN)", page 193, this
report presents offerings proposed via products to external org-units presented in

columns.

Report parameters

Parameter Parameter type Constraints

Market Org Unit At least one market mandatory.
Product Product At least one product mandatory.
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Business Process Contextualization Matrix (BPMN)

This report is a matrix presenting functional processes of the business process in
columns, and organizational processes of the business process in rows. When an
organizational process is the implementation of a functional process in a particular
context, this is displayed in the cell.

If a contextualization exists between a functional process and an organizational
process, it is presented in the corresponding cell.

w  For more details on the use of contextualizations, see the guide
MEGA Process BPMN Edition, "Defining Contextualizations" chapter.

Report parameters

Parameter Parameter type Constraints

Object Business process At least one object mandatory.

Contextualization Matrix (BPMN)

Like report "Business Process Contextualization Matrix (BPMN)", page 195, this
report enables identification of contextualizations representing the implementation
of organizational processes (specified as parameters and presented in rows)
between functional processes (presented in columns).

Report parameters
Parameter Parameter type Constraints
Organizational process Organizational process At least one process mandatory.
Functional process Functional process
Activity

Execution and Performance Heatmap

This report presents, in the form of a matrix, the assessment results of processes.

Assessed criteria

These characteristics relate to attribute values linked to process performance and
execution.
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List of characteristics linked to process performance:

Business Value: characterizes business value of the object.
Effectiveness: characterizes effectiveness of object operation
Risk: characterizes risks concerning the object.

Performance: this characteristic is a global assessment of process

performance. It is calculated from assessment of process business
value, effectiveness and risk.

List of characteristics linked to process execution:

Specification: assessment of quality of description of the object in
the repository.

Knowledge: assessment of knowledge of the object by stakeholders.
Support: assessment of application support of the object.
Execution: this characteristic is a global assessment of object
execution. It is calculated from assessment of object specification,
knowledge and support.

The results of this report can have two origins:

e the values of attributes linked to the characteristics assessed on objects
directly specified as "expert view" by the user

w  For more details, see "Expert view assessment", page 198.

e the questionnaires results aggregation that enable to get a value for
each attribute connected to assessed characteristics of each object
((Performance, Execution, for example).

w  For more details, see "Assessment by questionnaire"”, page 198.
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Report presentation

HOPEX Business Process Analysis Reports

This report is broken down into three parts:
e The first part details the performance assessment heatmaps.

© 2. Performance Heatmaps

[Add a comment for this chapter]

Performance View

Performance x Execution

@ 1y [l mefficient| ) msufficient| | Medium|) Good|l very Good|Sum|

Business value x Risk

= N,’Ali Very High‘“ High‘ Medium|u Lﬂw|Im Very Low | Sum|
o

=T 0 0|
. Very High
J High

' Medium

“ Low

. Very Low
‘ Sum

1
2
0
0
0
.0

u‘ 0 0 0 o 0.0

o
1
2
o
o
0

Efficiency View

Efficiency x Business value

= N,u’A’i Very Lcw|g Lcw| | Medium‘u High’i Very High|5“m
0

Efficiency x Risk

= N,'A|i Very High‘“ High‘ Medium|u Lcw|Im Very Low|Sum|
0 0 0

=
] Very High
[ High

' Medium

[ Low

. Very Low
‘ Sum

e The second part details the execution assessment heatmap.

Report parameters

Process Analysis

w  The values used for these reports can be obtained in different ways.
For more details, see "Expert view assessment”, page 198 and
"Assessment by questionnaire", page 198.

e The final part presents geographical distribution of org-units on sites.

Parameter

Parameter type

Constraints

Object

Business process
Organizational process

At least one object mandatory.
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Assessment

Expert view assessment

In the properties of an organizational
Assessment tab allows an expert user to specify values of attributes linked to
assessed characteristics.

B Properties of Investment Purchase Process (As

ssment - Global Assessment)

process or a business process, the

oXx

¥ General -  Characteristics - m Operations Flows & Roles  ~ Risks sta?;

~  EXECUTION

Design : Poor
Knowledge : Medium

iTsupport: [l Very Good

~  PERFORMANCE

Efficiency - Low
Business Value : [l Very Low
Risk - Medium

Assessment by questionnaire

w  To access assessment by questionnaire, you must have acquired

the MEGA Assessment module.

is carried out using assessment questionnaires. Assessment
questionnaires are sent to the appropriate addressees using customizable
deployment modes. Results are then aggregates according to predefined rules to
present results so they can be used.

w  For more details on the interface and assessment functions of
MEGA, see the MEGA Assessment guide.

Questionnaires

w To access assessment examples described in this guide, you must
have imported data specific to process assessments.
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Process Analysis

Questionnaires relate to characteristics to be assessed for all processes determined

as objects of assessment.

Assessed C| Possible Answers
Performance Business value |Risk 2 3 4
Business value
Performance indicators are defined and updated according to company objectives. cep | N/A Partially
What is process 1 pany objt MPP. x x N/A Low Medium High
Evaluate the process direct or indirect business value for the company x N/A Low Medium High
Identify the degree to which this process meets business needs. BPM x Low Medium High
How flexible the process is to satisfy changing business / user requirements. BPM  |x Medium Flexible
How does th ble you to reach ives assigned to you? x Partially -
Efficiency
Potential i (Cost) N High Medium Low
Potential i (Quality) M x High Medium Low
Potential i (Delay) M High Medium Low
Potential i (c M x High Medium Low
Are your clients (internal or external) satisfied of process course? x i Partially Satisfied | Satisfied
Are your clients (internal or external) satisfied of process results? x Partially Satisfied | Satisfied
Risks
What is the impact to the process if sustaining ions was not present? [apM x N/A High Medium Low
Are risks associated to process execution x B Partially
Does risks identified on the process often happen? x N/A Often Sometimes Rarely
C ts and
You can add a comment to justify your answers Text |

Fill free to add attachments justifying your answers

Org-Unit Analysis

This report details the organizational structure, the responsibilities and the sites
associated to the org-units specified as parameters.

This report is broken down into three parts:

e The first part details organizational structure of each org-unit specified
as parameter. In this part, the org-units analyzed are listed with their
type, parent, sub-org-units, persons involved in execution of the tasks

associated with the org-unit, including other information related to these
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persons. This part also displays statistical data: number of org-units,

number of persons.

=% Logistics Department

&% Car Rental Department

,5'?. Car Maintenance Department

,i'n Auto Repair Service Manager

,i?n Garage Technician

,i’-.'l Car Park Manager

Org-Unit Type Business Person

Structure

Structure

Structure

Function

Function

Function

Name ¥~  E-mail
George Edouard George.Edouard@organization.com

Name ¥~  E-mail
Jack Kcaj Jack Kcaj@organization.com
Thomas Masoht Thomas.Masoht@organization.com

Name v~  E-mail
Andrew Gilmore andrew.gilmore@oganization.Com
Jack Filston jack.filston@oganization. Com
Mathew Wehtam Mathew.Wehtam@organization.com

Philéas Phog phileas.phog@oganization.Com
René Dupont rene.dupont@oganization.Com
Steve Maglow  steve maglow@oganization.Com

The second part describes responsibilities of org-units. It presents detail
of operations executed by the org-units and the processes for which it is
responsible. This part also displays statistical data: maximum, minimum
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and average value of operations executed per org-unit, as well as

equivalent values for assigned processes.

Min. responsibilities per org-unit : 0
Max. respensibilities per org-unit : 55
Average number of responsibilities per org-unit : 6,5

Name v Org-Unit
Type ¥
®h Catalog Manager Function =
Michel Starbrock ]
The catalog manager is in charge of updating the cataleg in compliance with [ ]
o}
o}
o}
0
o]
o]
o}
o}
n CIo Function

Laurent Valrent

@0 CIO - America Function
Andrew Sketch

Responsibilities

Update Catalog - As Is
Update Catalog - To Be

Integrate New Negotiated
Travel Option

Integrate Regional Book
into Global Catalog

Remove Obsolete Travel
Options.

Review All Travel Options
Validity Dates

Design Text Centent

Integrate New Negotiated
Trawel Options

Integrate Regional Book
into Global Catalog
Remove Obsolete Travel
Options

Review All Travel Options
validity Dates

e The final part presents geographical distribution of org-units on sites.

3. Org-Unit Geographical Distribution

[Add a comment for this chapter]

LR

Name v Sites

|i:"| Catalog Manager

The catalog manager is in charge of updating the catalog in compliance with

I,\\;:"I CIO

@n CIO - America 1 California

ﬁ;‘l Clock-In Correspondent

8

w1 Controler

The controler, based at Head Office, audits company accounts and acts as advisor on tax optimization.

@ Customer Service Representative

The Customer Service Representative coordinates customer support pre-sale, during the journey and

thereafter if claims arise.

ﬁ;‘l Designer 1 Agency
Site

The designer is responsible for the graphical layout of the catalog including position of text and graphics.
He's also responsible for creating appropriate graphics to illustrate promotions.

Report parameters

Parameter Parameter type Constraints

Org-units ana- Org Unit

Not mandatory. If no value is given,
lyzed all org-units are analyzed.

w  Org-units can be distributed in sub-groups. In this case, statistical

values are calculated for each of these.

Process Analysis
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Site Analysis

This report details the geographical structure of the enterprise.

Report parameters

Parameter

Parameter type

Constraints

Sites analyzed

Site

Not mandatory. If no value is given,
all sites are analyzed.

w  Sjtes can be distributed in sub-groups. In this case, statistical
values are calculated for each of these.
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Risk Management

RISK MANAGEMENT

This paragraph presents the list of reports available from a BPMN process, on
condition of having access to the facilities of HOPEX concerning risk management.
e "Absolute Risks Heatmap", page 203
e "Matrix of Risks Incurred by Org-Units", page 203
"Matrix of Risks Concerning Sites", page 204

Absolute Risks Heatmap

This report inventories risks incurred by a set of processes.
Each risk linked to a capability is associated with a level of Severity (Negligible,

Significant, Critical or Strategic) and a level of Likelihood (Low, Moderate,
Probable or Frequent).

This report presents, in the form of a matrix, distribution of risks associated with a
list of capabilities related to criteria.

2. Absolute Risk Map Report Chapter

[Add a cormnment for this chapter]

Insignificant|Significant|Critical|Strategic
High o 1

Medium High |0 o
Medium

Report parameters

Subject of this report type is a set of processes.

Matrix of Risks Incurred by Org-Units

This report inventories risks incurred by a set of org-units.
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Report parameters

lyzed risks

Parameter Parameter type Constraints

Org-units Org-Units At least one object mandatory.
exposed to risks

Scope of ana- Risk Not mandatory. If no value is given,

all risks are analyzed.

Matrix of Risks Concerning Sites

This report inventories risks incurred by a set of sites.

Report parameters
Parameter Parameter type Constraints
Sites exposed to Sites At least one object mandatory.
risks
Scope of ana- Risks Not mandatory. If no value is given,

lyzed risks

all risks are analyzed.
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Data management .

DATA MANAGEMENT

This paragraph presents the list of reports available from a BPMN process, on
condition of having access to the facilities of HOPEX concerning data management.
e "Recommendation of Entities to be Managed", page 205
e "Data Models X Associated Elements Matrix", page 205
e "Data Model Implementation"”, page 206
e "Entities and Associations X Data Model Matrix", page 206

Recommendation of Entities to be Managed

Implementation of a process requires management of certain information entities.
This information is described either by linking a set of terms to the process, or by
associating a data model.

This report is broken down into three parts:

¢ Recommended Notions List, these notions are related to processes
analyzed, requiring their storage and management,

e Recommended Data Models List, these data models are associated
with processes analyzed,

e Recommended Data Models (Details) List provides detailed
information on data models associated with processes analyzed.

Report parameters
Parameter Parameter type Constraints
Processes business processes At least one object mandatory.

Data Models X Associated Elements Matrix

This tool analyzes objects described by data models.

This report is broken down into three parts:

e Data Models X Associated Elements Matrix, this part presents all
data models cross-referenced with repository described objects (of which
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the list is specified as parameter). All data model data is displayed in the
report.

¢ Recommended Data Models List, this part presents data models
analyzed cross-referenced with repository described objects. All data
model data is displayed in the report.

e All Data Models X Selected Elements, this part presents repository
data models cross-referenced with analyzed described objects. The
distinction between objects owned and used enables addition of further
information to data modeled by the data model.

Report parameters
Parameter Parameter type Constraints
Data models Data models At least one object mandatory.
Associated ele- Application, process, etc. | At least one object mandatory.
ments

Data Model Implementation

This report concerns follow-up of correspondence setting between data models. It
provides details of correspondence at the level of entities, their attributes and
associations. The charts enable display of the rate of progress of correspondences
already established.

This report is broken down into two parts:

e Data Models to be Implemented,
e Data Models to be Implemented

Report parameters
Parameter Parameter type Constraints
Data models Data models At least one object mandatory.

Entities and Associations X Data Model Matrix

This tool analyzes entities and associations according to data models.

This report is broken down into three parts:

e Entities and Associations X Data Model Matrix, data models
analyzed are cross-referenced with entities (DM) and associations (DM)
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Data management .

analyzed. The distinction between objects owned and used is displayed
in the report.

e Repository Entities and Associations X Data Model Matrix, data
models analyzed are cross-referenced with all entities (DM) and
associations (DM) of the repository. The distinction between objects
owned and used enables enhancement of data modeled by the data
model analyzed.

e Entities and Associations X Repository Data Model Matrix,
repository data models analyzed are cross-referenced with entities and
associations. The distinction between objects owned and used enables
addition of further information to data modeled by the data model.

Report parameters
Parameter Parameter type Constraints
Data models Data models At least one object mandatory.
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ANNEXE3 - HOPEX BUSINESS PROCESS
ANALYSIS WORKFLOW

This chapter presents HOPEX Business Process Analysis workflow diagrams.

v' HOPEX Business Process AnalysisReview Workflow
v Organizational process review workflow
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HOPEX BUSINESS PROCESS ANALYSISREVIEW
WORKFLOW

Roles on Objects

Object owners
The Owner is responsible for the following tasks:
e Risk identification
e Replying to questionnaires,
e Defining and implementing action plans
e Validating modifications made by the Business Architect in the context
of objects review workflows.
Owners exist for:
e Organizational
Process
Value chain
Business processes
e QOrganizational units

w To specify the owner of a process for example, open the properties
?'f /tcl}e process, select the Characteristics tab and complete the Owner
jeld.

Business architect

The business architect is the main user of the solution. Intervenes on the process
architecture at each project phase.

MEGA Business Architecture



Annexe3 - HOPEX Business Process Analysis Workflow
HOPEX Business Process AnalysisReview Workflow

Activating Process validation Workflow

Commands enabling activation of the different steps of a workflow are accessed
from the object itself.

" ORrcANIZATIONAL PROCESS

Organizational Process Diagram

Preview...
«, Share as Email
17 Add to Favorites
2, Review ie1 Activate

Depending on the status of the workflow associated with the object, the object
appears in the desktop of the user who must intervene to modify or validate it.

Home / My Workflows =%

My Terminated Workflows
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ORGANIZATIONAL PROCESS REVIEW WORKFLOW

Review workflow steps

The steps of the organizational process review process are described diagram
below.

......................................... Org-U nil Owner

) ) Business Architecture Functional Adtninistrator
Business Alchitects H ¢

E : Approve
Submit — . L L
Walidation in :
Ask for Modifications Progress Validated

Business Architecture Sunctional Administrator )

Update in
Progress

Org-Unit Owner

Ask for Updates Business Architects

Closed
Organizational Process Review Workflow Mails
Submit review request
From Business architect
To Organizational process owner
Subject Organizational process to be validated - [Organizational process name]
Content Sir, Madam,
Please validate organizational process: [Organizational process name]
To access the application and execute this task, [click here]
Comment: [Comment]
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Annexe3 - HOPEX Business Process Analysis Workflow
Organizational process review workflow

Request modification

From Organizational process owner

To Business architect

Subject Organizational process to be reviewed - [Organizational process name]

Content Sir, Madam,
Please review organizational process: [Organizational process name]
Comment: [Comment]

Notify validation

From Organizational process owner

To Business architect

Subject Organizational process validated - [Organizational process name]

Content Sir, Madam,
This organizational process has been validated: [Organizational process name]
Comment: [Comment]
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